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“Photoshop is a powerful tool, and although the basics can  
be  easy  to  grasp,  mastering  the  application  can  be  
extremely  difficult.  This  is  where  Mastering  Photoshop  
comes in: it takes readers through the app in depth and  
relates all tasks back to the creative process. There’s much  
to learn in here, for beginners and experts alike.”

— Elliot Jay Stocks, designer, illustrator and speaker
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Introduction
This book was written in the hope of filling a gap — a gap that has existed 
for as long as designers have been using Photoshop for Web design; a gap 
that we so often fill with tutorials focused on the latest trends and on 
inspiration galleries that are quickly browsed and forgotten; a gap that is 
growing as quickly as our technologies. It’s a gap of foundation.

The fast pace of the Internet has focused us on the latest and greatest 
techniques, which typically have a lifespan of only a few months. Rarely do 
we focus on the fundamentals, the principles that outlive the trends. 
Unfortunately, the principles are often less appealing than the shiny and 
new. Photoshop tutorials offer quick results. They hold our hands step by 
step until something incredible appears, but they rarely go in depth to 
explain the principles that enable us to create something unique and 
incredible of our own.

Mastering the fundamentals of our tools opens our minds and unlocks our 
inherent creativity. It helps us recognize the difference between timeless and 
trendy. It increases our efficiency and ultimately makes us and our work 
more valuable.

My hope is that this book helps you gain a deeper understanding of 
Photoshop. If you’re a beginner, I hope it gives you the comprehension you 
need to bring your ideas to life. If you’re a veteran, I hope it unveils some of 
the mysteries that have always boggled you. Ultimately, though, I hope this 
book increases your appreciation of the fundamentals and the subtleties 
that make Photoshop such a powerful tool.
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Chapter 1, Color Management

Maintaining a consistent appearance on  
the Web is difficult because you never  
know the end user’s environment. They  
may be viewing a website on their home 
computer or on a mobile device. They  
could be on a Windows platform or  
running a Mac. Even within these  
parameters, a multitude of other  
variables affect how their monitor is  
calibrated. All of these factors amount to  
an unremediable loss of control over the  
final output. Colors can appear lighter or 
darker, more or less saturated, cooler or 
warmer, or just plain wrong depending  
on the user’s environment. This can be  

quite a problem, especially with a client’s  
brand-specific colors As Web designers,  
our responsibility is to ensure that the  
experiences we craft are as true to the  
original as possible. To do this, you need 
to manage and align every step of the  
design process with how the majority of  
users will be viewing your work. This  
requires a complex and equally  
confusing system of color management.  
While it doesn’t completely solve the  
problem of color shifting, it makes it far  
less severe and ensures the maximum 
preservation of colors across a majority  
of devices.
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Calibrating the Display 
Gaining control of your color output starts by controlling your input (i.e. your 
monitor). A properly calibrated monitor is crucial: it lays the foundation for a 
properly managed workflow. Calibrating your monitor can be done with software, 
but it is better left to a colorimeter. Purchasing a colorimeter is a good idea if you’re 
concerned about accuracy. A number of companies sell affordable solutions: Monaco 
Optix, LaCie blue eye, basICColor displaySQUID, etc.  Whether you use hardware or 
software to calibrate your monitor, let your monitor warm up for about half an hour. 
Also ensure that the lighting in the room is soft and evenly distributed and that no 
light shines directly on the monitor.

Because our work will be displayed on both Macs and Windows machines, our 
gamma and white point should be set to the most common settings. Gamma is 
basically a value that represents the relationship between luminance values of the 

monitor. The higher the 
number, the darker the 
display appears. Windows 
machines run a gamma of 
2.2, while Macs run 1.8 — 
although, Snow Leopard now 
defaults to 2.2. A gamma of 
2.2 is the most common 
setting of Web users, and for 
this reason your monitor 
should be set to match. The 
most common white point is 
D65, and you’re best off 
following suit.
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The LaCie blue eye colorimeter
(http://bit.ly/cHphAV)

http://bit.ly/cHphAV


ICC Profiles 
Managing color across the ever-increasing spectrum of devices would be impossible 
without a universal standard. The International Color Consortium (ICC) has provided 
just that. By specifying vendor-neutral color specifications, the ICC has created the 
ability for devices to interpret and display color as intended. In order for the ICC 
specification to work, both devices and files need to have profiles attached to them. 
An image file’s ICC profile essentially tells the device how to interpret its color data, 
and the device’s profile tells the system how to display that color data.

Because the standard 
red, green and blue 
profile (or sRGB IEC 
61966-2.1) represents
a wide range of colors 
that can be replicated 
across a majority of 
devices, it has been 
adopted by the Internet 
world as its standard.

Therefore, you should 
create all of your work in 
this profile to maintain 
maximum consistency. 
For more information, 
see Color Settings on 
page 14.
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The sRGB color gamut.
(http://bit.ly/aYuSGV)
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Setting Up Photoshop
After you have calibrated your monitor, the next thing to manage is Photoshop. This 
is where things become slightly more complicated. You have two goals for color 
management in Photoshop. The first is to avoid color shifting when your file is 
exported and displayed in a Web browser. The second is to save the color data in the 
file so that it can be used and viewed consistently across different platforms. 

Color Management Module (CMM) 
Photoshop works with a Color Management Module (CMM), which is used to 
convert colors between ICC profiles. At the core of the module is the Profile 
Connection Space (PCS). This is the engine that processes a file’s raw data along with 
its ICC profile and tells the target device how to display it based on its profile. 

Understanding this process is important, because the colors you see in Photoshop 
are not necessarily the actual colors of the file. For example, if your working space is 
set to sRGB (more on this in the next section), and you examine a brownish color 
(let’s say 161, 121, 69) using the Mac’s DigitalColor Meter, you’ll notice that the 
display is actually outputting 140, 103, 56. That’s quite a shift, especially in the blue 
channel. This is because the document is telling the PCS that the file should be 
converted first to the 
sRGB profile and then 
converted to the 
monitor’s profile.
In order to view the 
raw color values, we 
can assign the 
document a different 
profile by going to 
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Color shifting from raw data with an sRGB profile and monitor profile.  



Edit → Assign Profile. If we change the Profile in the drop-down menu to our 
monitor’s profile, then the colors will shift to display at their actual values. So, now 
our document is telling the PCS to convert the raw data directly to the monitor’s 
profile, thereby bypassing the sRGB conversion, which caused the initial color shift. 
This can be quite confusing, and discrepancies in the working space can cause a 
massive headache once you introduce the browser into the workflow. Many browsers 
completely ignore embedded ICC profiles, and the GIF and PNG formats don’t even 
support them. This leads to color shifts and can even cause browsers to render an 
image differently. Luckily, there’s a way to simplify the whole process: by properly 
managing your working space. 

Color Settings 
If left at its defaults, Photoshop will export files that shift in color when viewed in the 
browser. This is due to Photoshop’s default working space, which is Adobe RGB. 
While this profile is great for photographic work that’s meant to be printed, it will 
wreak havoc on your Web designs. For this reason, you need to change your working 
space. There seems to be two schools of thought on which working space is best for 
the Web. Some argue that the working space profile should match your monitor’s 
profile, while others suggest using sRGB. Both of these methods can actually achieve 
the same result, but in different ways. 

Using your monitor’s profile as the working space has the benefit of simplicity. 
There’s no need for any conversion or proofing. However, you need to ensure that 
the “Convert to sRGB” option is turned off in the “Save for Web and Devices” dialog. 
Otherwise, your colors will shift. This method is extremely simple and works well for 
a one-person shop. However, you are essentially binding the document to the 
monitor’s profile. If you were to open the PSD on a different machine, the color 
values will remain the same, but they will display differently, which can be quite 
deceiving.
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To maintain the highest degree of consistency in both your exports and your PSDs, I 
recommend using a set standard for all your working spaces: sRGB. The sRGB profile 
provides a baseline from which all machines can accurately reproduce color. 
However, when you set the working space to sRGB, the document’s appearance will 
not match what is ultimately rendered in the browser (unless you embed an ICC 
profile and the browser is adept at interpreting it). 

This can be easily remedied by working with a soft proof. Under View → Proof Setup, 
change the setting to “Monitor RGB.” Then, make sure that View → Proof Colors is 
checked. You should see a change in your document. This is identical to how the 
image will appear in the browser. Working with Proof Colors can be tricky to 
remember, but it’s worth getting into the habit of proofing.

The bottom line here is that using an sRGB working space is the best solution for 
ensuring consistency in Photoshop and in exported images. That being said, make 
sure while you’re working to have your Proof Colors on and set to your monitor’s 
profile. When you “Save for Web and Devices,” it doesn’t matter whether “Convert to 

sRGB” is on or off, but 
make sure that “Embed 
Color Profile” is off. 

To change your working 
space, open the Color 
Settings dialog (Edit → 
Color Settings). You can 
then change the RGB 
Working Space to sRGB 
IEC61966-2.1. You’ll also 
notice a number of other 
settings in this dialog.  
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sRGB.



Aside: Modern Browsers and Color Management
In the past, all browsers completely ignored embedded ICC profiles. However, more 
and more browsers are starting to accept them. Once all browsers are up to date on 
color management, your workflow will vary from what we’ve just discussed. 
Fortunately, you’ll already be accustomed to working in the sRGB color space, and 
you’ll only need to start including the profile when saving your files by checking the 
”Embed Color Profile” option. 

Color Management Policies 
The Color Management Policies section gives you control over how discrepancies in 
profiles are handled. For example, when copying and pasting an image with a profile 
other than the current working space, you’ll want to control how that file is 
converted.  I recommend leaving RGB, CMYK and Gray on “Preserve Embedded 
Profiles,” with both of the Profile Mismatches checked. When you open or paste a file 
with an opposing profile, Photoshop will ask whether you’d like to convert the file to 
the current working space, keep the current profile or ignore color management 
altogether. 
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When a file’s  
profile doesn’t  
match the  
current  
working  
space, the  
Color  
Management  
Policies  
determine  
how to  
handle the  
discrepancy. 



Note that the conversion process from one profile to another is destructive. The 
sRGB color space is, in fact, significantly smaller than, say, Adobe RGB. Therefore, 
when converting from Adobe RGB to sRGB, you’ll be clipping a lot of data. This is a 
necessary evil and should be done only when necessary. 

Conversion Options and Advanced Options 
If you click the “More Options” button in the Color Settings dialog box, you’ll be 
presented with a couple of extra options. The first are the Conversion Options, which 
control how images in one profile are converted to another. These are pretty 
advanced options and probably don’t need to be altered for a typical Web design 
workflow. However, you may have some luck changing the Intent to “Absolute 
Colorimetric” when converting extremely sensitive colors, such as those found in a 
logo. The Advanced Options are less useful when working on the Web. They’re 
basically used to simulate other devices and print output. On the whole, these 
options can all be left as they are.

Assign Profile 

The “Assign Profile” option can be used to change the profile associated with a 
document without actually converting the data. This can be helpful if a document 
has somehow lost its profile but you know the profile that should be associated with 
it. Otherwise, using this option is a shot in the dark. You can cycle through different 
profiles and might hit one that properly reproduces the original. 
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The Assign Profile dialog can be used to shift an image’s profile without conversion or gamut  
clipping.



Convert to Profile 

If an image contains a profile other than the current working space, it will need to be 
converted before it can be included in your sRGB document. As stated, converting a 
document to a different profile will result in destruction of the raw data. Therefore, 
aim to convert a file only once: from its source space directly to the working space.

Photoshop uses a rendering engine to process from the source space to the 
destination space using different algorithms. Each algorithm (or “Intent” as it’s 
referred to in the dialog) specializes in a different kind of conversion. Sticking with 
the default of “Relative Colorimetric” is probably best, because it seeks to reproduce 
colors as close to their originals as possible while preserving highlight values. The 
“Absolute Colorimetric” intent can be used to try to preserve signature colors. 
“Perceptual” aims to reproduce colors the way the human eye perceives them while 
straying from the raw color values; this can used to some effect in converting 
photographs. Finally, the “Saturation” intent pumps up the saturation without staying 
true to the original colors and their relativity to each other.
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The “Convert to Profile” dialog converts raw color data to fit the gamut of the Destination  
Space.



The Quick Set-Up 

To recap, setting up your system for color management is extremely important for 
reproducing your Photoshop document on the Web. And while Color Management 
as a subject can be confusing, the set-up is really quite simple: 

1. Calibrate your monitor with a gamma of 2.2 and a white point of D65.
2. Set Photoshop’s working space to sRGB.
3. Use Photoshop’s “Proof Colors” command to proof all documents in Monitor 

RGB.
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Chapter 2, Paths

Photoshop is such a robust application  
that performing a simple task can often  
be done in three or four different ways.  
While the case could be made that you  
should work with whatever tools you feel  
most comfortable with, there are certain  
cases in which one methodology proves  
to be superior. 

Using paths is one method that will  
change your entire approach to Web 
design. You could, of course, build your  
document using raster layers, but the  
flexibility inherent to paths allows you to  
quickly and easily resize elements  
without losing quality, making them the  
perfect foundation for interfaces. 

Despite the ease and precision afforded  
by paths, many designers shy away from 
them — perhaps because Illustrator is  
regarded as Adobe’s vector platform and  
Photoshop primarily as the raster 
platform. While Illustrator’s vector tools  
are much more powerful, Photoshop’s  
added benefit lies in its ability to blend  
vector and raster data together  
seamlessly. Because Photoshop  
documents are based on a pixel grid, the  
path tools make them superior to  
Illustrator for designing on-screen media.

In this chapter, we’ll cover the tools  
necessary to create flexible and pixel-
perfect interface elements with paths.
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Bézier Basics
Paths are the building blocks of the vector graphics format (a format that represents 
images based on mathematical equations). This is in contrast to the raster format, 
which uses a grid of pixels. Photoshop documents are unique in that they are based 
on a pixel grid but allow the use of vector elements. Vector paths are ultimately 
processed on the pixel grid, but the PSD format — as well as a few others, such as 
EPS and TIF — saves the vector data so that you never have to rasterize it. This 
dramatically increases flexibility and productivity, making paths an indispensable 
tool.

Paths consist of a series of anchor points, each of which has two handles that dictate 
the curvature of the lines connecting it to other anchor points. The mathematical 
basis of paths allows them to be scaled indefinitely without losing the smoothness of 
their curves (referred to as Bézier curves). Photoshop provides a number of tools that 
allow you to create and modify paths, and there is a variety of ways to implement 
them.

Path Creation Tools
Pen Tool 

The Pen Tool (P) is the most dynamic path creation tool available to Web designers. 
While it is not really suited to creating geometric shapes, it shines with organic 
forms. It provides a precise means for creating paths, but it requires an experienced 
hand to plot naturally flowing curves. A lot of practice is necessary to feel 
comfortable with it, but mastering the Pen Tool is well worth the time invested.

Photoshop provides two different pen tools: the standard Pen and the Freeform Pen. 
Although it requires manually drawing every line segment, the standard Pen Tool is 
best suited to nearly every task. The Freeform Pen can be handy — with the 
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Magnetic option turned on — for quickly tracing an object, but the path is rarely as 
clean as it should be. At first, using the Pen Tool involves a lot of trial and error, but 
rest assured, there is a methodology to creating well-formed paths.

Start in a Corner

The first point in a path is probably the trickiest, because you cannot see how the 
final point in the path connects to it. For this reason, starting in a sharp corner is 
best. This way, when you reach the end of the path you won’t have to worry about 
the smoothness of the curve.

Add Points Where Necessary

First, add points wherever there is an abruptness or sharp change in direction. The 
directional handles on these points will typically create an acute angle, if any handles 
are even necessary. “On-curve” points are a little trickier. Add them where they feel 
most natural — typically at or near all optical apexes.

Keep Points to a Minimum

It may seem that the more points that are along your path, the more accurate the 
path will be. However, this typically makes for jagged and awkward paths. Using as 
few points as possible is always good practice. Just remember: the fewer, the 
smoother. 

Use the Rubber Band Option

To set anchor points exactly where you’d like them, you can turn on the “Rubber 
Band” option, located in the drop-down menu next to the Custom Shape Tool button 
in the Pen’s property bar. This setting allows you to see the curve connecting the last 
anchor point to the mouse’s current position. 
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Spring-Loaded Tools

The Pen Tool has a number of hidden capabilities known as spring-loaded tools that 
make it the most powerful tool for creating and editing paths.

Convert to Point Tool: Option (Alt) while hovering over an anchor point
Direct Selection Tool: Command (Control)
Path Selection Tool: Command + Option (Control + Alt)
Group Selection Tool: Command + Option (Control + Alt) while hovering over a path 
segment or anchor point
Add Anchor Point Tool: Hover over path segment
Subtract Anchor Point Tool: Hover over anchor point
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Shape Tool

The Shape Tool (U) gives you access to standard geometric shapes. Perhaps the most 
useful of the Shape Tools are the Rectangle and Rounded Rectangle Tools. These two 
tools are indispensable and can and should be used as the basis of a majority of your 
design elements: buttons, frames, masks, menu bars, etc.

Depending on the shape you’re drawing, a few settings might help. First and 
foremost is the mode. Like the Pen Tool, the Shape Tool can be used in three 
different modes. These modes specify how the tool will implement the shape: as a 
shape layer, as a path or by filling pixels. For more information on these modes, refer 
to “Path Usage: Modes” on page 27. In addition to the mode, there are advanced 
options unique to the shape that can be found in the drop-down menu in the 
properties bar. These give you access to options such as snapping to pixels, 
constraining proportions, adding arrowheads, etc. 

 
Photoshop also gives you the ability to create more complex shapes using the 
Custom Shape Tool. The default library is limited, but other libraries of custom 
shapes are accessible from the Shape drop-down’s flyout menu. To define your own 
custom shape, select the shape’s path using the Path Selection Tool (A), right-click 
inside the canvas, select “Define Custom Shape,” name it and click OK. The shape will 
then be appended to the Shape drop-down in the property bar. 
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The Perfectionist’s Way 
Every Photoshop document is built on a grid of pixels, but paths are not constricted 
to the pixel grid like raster data is. An anchor point can actually reside between pixel 
edges. This can allow for greater flexibility when creating dynamic shapes, but it can 
also lead to undesirable anti-aliasing, especially along horizontal and vertical lines. 
One of the best ways to prevent this from happening is by using the Snap to Pixels 
option located in the Shape Tool’s property bar. Now when drawing a shape, the 
beginning and end points are guaranteed to be perfectly aligned on the pixel grid.

If you run into an off-pixel 
anchor point, it can be 
easily fixed by nudging it 
while zoomed in. First, 
zoom in as far as possible; 
the further zoomed in you 
are, the smaller the 
increment of each nudge. 
Then, use the Direct 

Selection Tool (A) to select the anchor point, and use the arrow keys to nudge it into 
position (clicking and dragging will move the anchor point in only one-pixel 
increments). The Pixel Grid (Show → Pixel Grid) comes in handy when doing this. 

Type Tool

Converting type to a shape layer allows you to work directly with the anchors and 
curves of each letter, and it might even improve your typesetting. Because you will 
be sacrificing the ability to edit the text, this technique is most useful when you know 
that the text won’t change. With the type layer selected, right-click the layer in the 
Layers palette and choose “Convert Type to Shape.” You can now access the actual 
paths used to create the type. Thinking of type in this manner (as shapes instead 
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of letters) dramatically 
changes the way you 
work. Kerning is now 
more intuitive: just 
select a letter and 
move it — no pesky 
integers to set!  

Other Creation Methods
Selections

Editing paths is far superior to editing raster data, especially when it comes to 
scaling. If the raster shape is simple enough, why not convert it to a path? Select 
your shape, then from the flyout menu in the Paths palette, select “Make Work Path,” 
or Option-click the “Make work path from selection” button at the bottom of the 
palette. Set the tolerance based on the complexity of the shape: the simpler the 
shape, the higher the 
tolerance. Click OK. 

You’ll notice that 
pixel-to-path 
conversion is not an 
exact science, but 
with some manual 
clean-up, you can 
effectively recreate 
the original shape.

Smashing eBook Series: #3 | Mastering Photoshop for Web Design | 26

Chapter 2, Paths

Type-to-path conversion.

Selection-to-path conversion.



Importing and Exporting

While Photoshop provides vector tools that are sufficient for many basic tasks, it in 
no way compares to the ease and power of Illustrator. Fortunately, Adobe products 
work in unison. You can create paths in Illustrator and easily import them by copying 
(Command/Control + C) and pasting (Command/Control + V) in Photoshop. In the 
paste dialog box, select either “Path” to import a Work Path or “Shape Layer” to 
create a fill layer with the foreground color.  In case you need to translate your paths 
in the opposite direction, copying and pasting will work as above, or you can use 
Export → Paths to Illustrator to create a new Illustrator document with the same 
dimensions and positions as the current Photoshop document.

Pixel Perfection 

Moving a shape such as a logo from Illustrator into Photoshop and having it anti-
alias properly can be difficult. Importing it as a Smart Object allows you to resize and 
translate it as a whole until things line up better with the pixel grid. However, for 
maximum control over individual elements, try importing it as a shape layer. Now 
you can work with the individual paths to perfectly align every element. If the logo 
consists of multiple colors, you may need to import the entire logo as a shape layer 
and then separate each color into its own shape layer. While this may not work for 
more complex shapes, the improvement in crispness can be extreme. 

Path Usage
Modes

When creating paths via the Pen or Shape Tool, three settings — found in the tool’s 
property bar — are available to define how the path should be used: Shape Layer, 
Paths and Fill Pixels. The Shape Layer setting automatically creates a new fill layer 
using the color and layer style set to the right. 
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Paths create a temporary Work Path accessible in the Paths palette, which makes it 
available for many different implementations. Fill Pixels paints raster data on the 
current layer, leaving no paths behind. 

 

Shape Layer

Shape layers are the key to flexible interface construction. The ability to quickly 
resize, reshape and recolor them can save you hours of frustration on large projects. 
They are ideal for creating one-layer buttons and can even be filled with gradients or 
patterns without the use of layer styles.
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Shape Layer.

     

     Creating a gradient shape layer.



Command-
clicking  
(Control-
clicking  to  
quickly  
create a  
Vector Mask.

A shape layer is essentially a fill layer with a vector mask. It can be created as a solid 
color, gradient or pattern, although only the foremost is explicitly available. The 
easiest way to create a shape layer is to use a path drawing tool set to Shape Layer. 
However, setting the tool to Paths allows you to specify the type of fill to be used. 
First, draw your path. Then, click the “Create new fill or adjustment layer” in the 
Layer’s palette and choose from Solid, Gradient or Pattern. Note that you can also 
create an adjustment layer with a vector mask in the same manner. 

Vector Mask

Vector masks are often preferable to raster masks because they can be easily 
tweaked and scaled and still produce a crisp edge. With CS4’s introduction of the 
Masks palette, vector masks are more powerful than ever. Now, you can feather the 
edges and adjust the density of a vector mask. The quickest way to create a vector 
mask is to select the layer you wish to mask. Then, select the path using the Path 
Selection Tool (A) and Command-click (Control-click) the “Add Layer Mask” button at 
the bottom of the Layer’s palette.  
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Type Paths: In and On

There are two ways 
to use paths with 
the type tool: by 
defining the 
baseline or by 
creating a custom 
text box shape. 
Select the work path 
you’d like to use, 
and with the Type 
Tool (T) mouse over 
the path. 

The dotted square on the cursor will 
change to a curved line. Click on the 
path, and you’ll see that the type 
flows right along the path. After 
committing the type (Command / 
Control + Enter), you can use the 
Path Selection Tool (A) to move the 
beginning and end points — 
indicated by an “x” and a black
circle, respectively — or to flip the 
type from the top of the line to the 
bottom. If using a closed path, you 
can click inside it to create a custom-
shaped text box. These are helpful 
when wrapping text around an object. 
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Fill and Stroke

The Paths palette provides an interesting array of options to fill and stroke a work 
path. These options are available only when the current layer is a raster layer — you 
can quickly create a new raster layer using Command + Option + Shift + N (Control 
+ Alt + Shift + N). Then, by Option-clicking (Alt-clicking) on the “Fill path with 
foreground color” button, you can open the Fill Path dialog box. 

From here, you can set the fill type, blending modes, transparency and feathering. 
Option-clicking (Alt-clicking) the “Stroke path with brush” button will open the 
Stroke Path dialog box, which allows you to choose a tool to stroke with. The stroke 
will adopt the foreground color and the selected tool’s current settings. 
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  Stroke tools.

Boolean Operators

To allow for more 
complex shapes, multiple 
paths can be grouped 
together in a compound 
path, on which Boolean 
operations can be set. 

These are accessible in 
the properties bar of the 
Pen Tool, Shape Tool and 
Path Selection Tool, and 
they include:
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Add (+): specifies a fill area.

Subtract (-): defines an area that is not filled. If only one path exists, then the entire 
canvas is considered the fill area, from which the shape is subtracted.

Intersect: sets the fill to areas included in all paths.

Exclude: fills all path areas except those that overlap. 

Stacking Order

When creating compound paths, note the positions of the paths in the stacking 
order. A compound shape with an add path on the bottom and a subtract on top will 
be completely different with swapped depths. A path’s Boolean operator takes effect 
on all of the paths below it. Unfortunately, there are no commands or palettes to 
simply swap depths in Photoshop; you’ll need to use a series of cut (Command / 
Control + X) and paste (Command / Control + V) commands to rearrange them. 
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Combining

Combining paths can reduce complexity by creating a single path from the perimeter 
of a compound path’s fill area. To do this, select the paths to combine using the Path 
Selection Tool (A), and click the Combine button in the Tool Properties bar. 

Quick Tips
One-Layer Buttons

Buttons are an unavoidable element in interface design. You’ll undoubtedly need to 
create many of them, and maintaining a consistent style for every button will 
maximize usability. By simplifying buttons to a single resizable layer, the task of 
replicating and managing buttons is made much easier. Using paths in conjunction 
with layer styles is assuredly the best basis for achieving concise buttons.

Step by Step

1. Select the Rounded Rectangle Tool, and set the mode to Paths and the Radius 
to 6 pixels. It’s a good idea to open the advanced settings and turn on Snap 
to Pixels. 

2. Draw an elongated rectangle. 
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3. In the Layer’s palette, click the “Create new fill or adjustment layer” button, 
and choose “Gradient.” 

4. Click the gradient’s icon to edit it. Set the right color stop to a dark red color 
and the left stop to a brighter orange color. Drag the bottom-right slider over 
so that its Location reads 45%, and click OK. 

5. Click OK to close the Gradient Fill dialog box. Then, open the Blending 
Options dialog by Option + double-clicking (Alt + double-clicking) the layer’s 
thumbnail in the layer’s palette. 

6. Add a Gradient Overlay, and click on the gradient’s thumbnail. Change both of 
the color stops to white. 

7. Modify the left opacity stop to 0%, and make sure the right opacity stop is set 
to 100%. Also, create two new opacity stops by clicking directly above the 
gradient bar. Set the first’s location to 49% and its opacity to 0%. Place the 
second at 50%, and set its opacity to 25%. Then, click OK. 

8. Change the Blend Mode to Linear Dodge (Add), and knock the opacity down 
to about 65%. 

You should now have a shiny new button contained nicely on one layer. Because the 
button was built with paths and styles, you can easily resize it to use throughout your 
design.

Wrapping Type

Photoshop’s Type Tool is not nearly as robust as Illustrator’s or InDesign’s, but you 
can still achieve many of the same effects through various workarounds. The Type 
Tool allows you to click and drag to create a paragraph text block. However, there’s 
no way to then alter the shape of the text block to anything but a rectangle. By first 
creating a work path in the desired shape, you can then turn it into a type holder by 
selecting the Type Tool (T) and clicking inside the shape. You can then modify the 
path, and the text will automatically wrap inside the shape. 
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Keyboard Shortcuts

Pen Tool (P)

Shift + P
toggle between Pen Tool and Freeform 
Pen Tool 

Shift constrains to 45° angles 

Option
change to Convert to Point Tool, used to 
set directional handles 

Command (Control)
change to Directt Selection Tool, used to 
move anchor points or stretch line 
segments 

Command + Shift (Control + Shift)
select multiple anchor points and 
segments 

Command + Option (Control + Alt)
change to Group Selection Tool, used to 
select entire paths 

Command + Option + Shift (Control 
+ Alt + Shift)

select multiple paths 

+ set Boolean mode to Add 

- set Boolean mode to Subtract 

Shape Tool (U)

Shift + U rotate through Shape tools 

Shift constrain proportions 
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Option (Alt) while dragging draw from center of shape 

Option (Alt) before clicking, if set to 
create Shape Layers

temporarily switch to Eye-Dropper tool 

Option (Alt) before and while 
dragging, if set to create Paths

set Boolean mode to Subtract 

Option + Shift (Alt + Shift) before 
and while dragging, if set to create 
Paths

set Boolean mode to Intersect 

Command (Control)
change to Path Selection Tool, used to 
select and move paths 

Command + Shift (Control + Shift) select multiple paths 

+ set Boolean mode to Add 

- set Boolean mode to Subtract 

Space bar (while dragging) move the shape’s origint

Path Selection Tool (A)

Shift + A or Command-click (Control-
click) inside document window

toggle between Path Selection Tool and 
Direct Selection Tool 

Shift + Click select multiple

Shift + Drag move and snap to 45° angles 

Command + Option (Control + Alt) convert to Shape Tool 

Command + Option + Shift (Control 
+ Alt + Shift)

convert to Shape Tool (constrained to 
45° angles) 

Option (Alt) change to Group Selection Tool 
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Option + Click + Drag (Alt + Click + 
Drag)

duplicate selected path 

Arrow
nudge selected path or anchor point 1 
pixel 

Shift + Arrow
nudge selected path or anchor point 10 
pixels 

Option + Arrow (Alt + Arrow)
duplicate selected path or anchor point 
and move copy 1 pixel 

Option + Shift + Arrow (Alt + Shift + 
Arrow)

duplicate selected path or anchor point 
and move copy 10 pixels 

Target Path

Enter dismiss target path 

Command + Enter (Control + Enter) selection from target path 

Command + Option + Enter (Control 
+ Alt + Enter)

subtract path area from current selection 

Command + Option + Shift + Enter 
(Control + Alt + Shift + Enter)

intersect path area from current 
selection 

Command + T (Control + T) Free Transform Path 

Command + Shift + T (Control + Shift 
+ T)

Free Transform Path again 

Command + C (Control + C)
copy path or anchor point with 
neighboring points

Command + X (Control + X) cut path or anchor point with
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Chapter 3, Layer Styles

In the previous chapter, we covered the  
benefits of using paths in your  
documents, but paths alone can make  
for a rather dull design. This is where  
Photoshop’s Layer Styles come in. They  
allow you to add depth and tactility; and 
because they can be easily copied and  
modified, they help maintain consistency  
across different elements of a website.  

Layer Styles are essential to creating  
flexible and non-degradable documents, 
because they’re separated from the  
layer’s actual content. In this chapter, 
we’ll cover how to create great-looking 
and reusable styles. We’ll also cover  
some unique effects and non-typical uses  
that help to consolidate excess layers.
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Basics
Layer Styles are a set of commonly used effects that can be applied to a layer 
without affecting the data of the layer itself. Before Layer Styles were introduced, 
these effects had to be created manually using numerous layers and adjustments. 
This often resulted in a mess of layers just to create one simple effect. Now with a 

few clicks, we can easily create, duplicate, 
modify and remove styles. Learning when and 
how to use Layer Styles can greatly increase a 
designer’s productivity.

The Layer Styles dialog box is not readily 
available but can be quickly accessed in a few 
ways. My personal favorite is by double-clicking 
on a layer’s thumbnail in the Layers palette — if 
it’s a shape or type layer, then you’ll need to 
Option + double-click (Alt + double-click).

You can also Control-click (right-click) on a layer 
and select “Blending Options” or use the “Add a 
layer style” button at the bottom of the Layers 
palette to select a particular effect.

Effects
Along the left side of the dialog box is a menu with a number of effects. Adding an 
effect can be as simple as clicking one of the check boxes. However, the default is 
rarely appropriate. To access more options for the effect, you must click on its name. 
Each effect has a number of settings that can be tweaked: blend mode, color, size, 
contour, etc. While there is no magic formula for creating a great layer style, there 
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are some techniques you can employ to maximize your effort. Below are some tips 
to help you get better results from your layer styles.

Blend Modes for Better Color

The default blend modes for some of the effects are good enough, but they can 
often appear dull and unnatural. For example, using Multiply for a black drop 
shadow against a brightly colored background can result in a shadow that is 
abnormally gray, breaking the sense of reality. 

By changing the 
Blend Mode to 
Linear Burn and 
also reducing the 
opacity, the 
shadow will adopt 
more color from 
the background. 
The very same 
technique works 
well for effects 
that typically use 
Screen. Changing it to Linear Dodge will be more intense, but when the opacity is 
reduced you can achieve a more realistic feel.

Color-Independent Effects

When possible, keep absolute color values out of your layer styles. Especially with 
things like buttons, which can be of myriad colors, you may want to try building a 
layer style with relative effects. For example, if we have two simple buttons, one blue 
and one red, we could add a Gradient Overlay that gradates from a bright red to a 
dark red for the first and a bright blue to a dark blue for the second.
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However, if the layers are already red and blue, then we can simply add a gradient 
that ramps from black to white and change the blend mode to Linear Burn. We can 
then reuse one layer style for buttons of any color while maintaining a consistent 
look.

Remember the Stacking Order

You may have noticed that sometimes an effect isn’t visible when another effect is 
being used. For example, a Color Overlay seems to override a Gradient Overlay. This 
is due to the Layer Styles stacking order. Just as with the Layer’s Palette, one layer will 
cover another that is lower in the stacking order. 

Unfortunately, the Layer Styles menu doesn’t allow you to rearrange the order of 
effects. One way around this (although you will sacrifice the ability to edit) is to use 
Create Layers, which will turn all of your Layer Style effects into actual layers that you 
can then move (see page 50).
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Interior Effects Stacking Order:

    •  Bevel and Emboss
    •  Stroke
    •  Inner Shadow
    •  Inner Glow
    •  Satin
    •  Color Overlay
    •  Gradient Overlay
    •  Pattern Overlay

Exterior Effects Stacking Order:

    •  Stroke
    •  Outer Glow
    •  Drop Shadow

Avoid Bevel and Emboss

Bevel and Emboss is great in theory but pretty ugly in practice. It is quite possibly the 
most abused layer style in the arsenal. We’ve all witnessed poor typography made 
worse with a gaudy Bevel and Emboss. Photoshop’s attempts to simulate light and 
shadow on a beveled surface are quirky and unrealistic. This is not to say that a 
beveled look can’t be created using layer styles; there is simply a better method. By 
using a combination of Inner Shadow and Inner Glow, you can create a crisper and 
more customizable bevel. Use a black Inner Glow set to Multiply or Linear Burn for a 
shadow. Then, use a white Inner Shadow set to Linear Dodge for the highlight. 

This technique 
gives you far 
better control of 
the output and is 
great for buttons 
and beveled UI 
elements.
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Change the Light’s Angle

The Inner Shadow and Drop Shadow effects are cast based on the Angle setting. By 
default, this is set to 120°, which corresponds to our gestalt’s preference for an 
upper-left light source. This, however, is not always ideal. In fact, because this angle 
is slightly more upward than leftward, adding a tight drop shadow can look 
awkward. 

Changing it to 135° will give you 
perfectly upper-left angled 
effects. For example, by 
changing the angle to 135°, 
setting the size to 0 and the 
distance to 1, we add an evenly 
distributed shadow to the 
bottom and right of an object.

Blend Options
The Blend Options menu gives you control over how the layer and its effects blend 
with the rest of the document. In addition to the standard fill, opacity and blend 
mode settings, you also have controls for the application of masks, value-based 
blending sliders, layer-only channels and more. These options are powerful and 
worth going into in depth.

General Blending

The two settings in the General Blending section should be pretty familiar. They’re 
the same controls found on the Layers palette. Blend mode changes how the entire 
layer blends with the layers below it, and opacity changes the transparency along 
with all of its effects.
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Advanced Blending

In the Advanced Blending section are some really powerful settings that are often 
overlooked. The Fill Opacity setting is the same as the Fill in the Layers palette: it 
controls the transparency of the actual layer data and not any of the effects applied 
to it. The Channels check boxes allow you to control which channels of the current 
layer are shown.

Knockout provides two options for subtracting the current layer from the layers 
below it. By using Shallow or Deep, all opaque pixels on the current layer will cut 
through the layers below it. If the layer’s fill is set to 100%, this may not be 
immediately obvious, but after changing it to 0% you should see underlying layers 
showing through. 

The layer that comes through the Knockout depends on which setting you’ve used 
and where the current layer is in the layer stack. The Deep setting will always show 
the background layer. If there is no background layer, then the area will be 
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transparent. Shallow works the same way as Deep, unless the current layer is in a 
group, in which case it cuts through to the bottom-most layer of the group. These 
settings can be really handy for removing certain areas of a large stack of layers.

Tip

You can turn any layer into a background layer by selecting Layer → New → 
Background from Layer. There are five additional options in the Advanced Blending 
section that deal primarily with how the layer’s effects are defined. By default, “Blend 
Clipped Layers as Group” and “Transparency Shapes Layer” are checked. Blend 
Clipped Layers as Group controls how the blending modes of any clipped layers 
affect the layer they’re clipped to. With this option selected, all clipped layers will 
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first blend with the base layer, and then the composited base layer will apply its 
blend mode to the layers beneath it. 

However, when the Blend Clipped Layers as Group option is turned off, each of the 
clipped layers and the base layer will apply their individual blend modes. 
Transparency Shapes Layer controls the area within which the effects are constrained. 
If checked, the layer’s data acts as bounds for the effects. Otherwise, the bounds will 
be the entire canvas, and certain effects will not render.

The Blend Interior Effects as Group option will cause all effects that modify the 
original layer data to act as part of it. For example, if a layer has a default gradient 
overlay on it, and we turn the Fill Opacity to 0%, then the gradient will still be 
displayed at 100% 
opacity. However,
if we now turn on 
Blend Interior Effects 
as Group, then the 
gradient will also 
adopt the 0% 
opacity.

The final two 
options (“Layer Mask 
Hides Effects” and 
“Vector Mask Hides 
Effects”) modify the 
bounds that define the effects. When they’re both unchecked, any opaque areas of 
the layer are used to define the bounds. Turning one of these options on removes 
the mask’s influence on the boundaries and instead hides any effects lying outside of 
its active area.
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Blend If

At the bottom of the 
Blending Options menu 
are two extremely 
powerful sliders, which 
control the transparency 
of pixels. This Layer slider 
dictates the transparency 
of each pixel of the current 
layer based on its bit value 
(from 0 to 255). Sliding the 
black stops to the right 
gradually causes the 
darkest pixels of the layer 
to become completely 
transparent, and dragging 
the white stops to the left 
in turn causes the lightest 
pixels to disappear. This is extremely helpful when extracting something like a logo 
from a white background. However, you’ll notice that there’s no gradation in 
transparency, resulting in unsightly aliased edges. To achieve a smooth anti-aliased 
edge, you need to split the color stops. By holding Option (Alt), you can move each 
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half of the color stop independently. The Underlying Layer slider works in a similar 
fashion, except that it bases the transparency of the current layer on the bit values of 
the visible data below it. You can also set the opacity based on values from a 
particular channel by changing the settings in the Blend If drop-down menu. 

Contextual Controls
The Layers palette has some convenient, though inconspicuous, options to help you 
manage styles. By right-clicking on either the fx icon or the effects list, you can 
quickly access the blending options or any of the effects. What’s more, you’re also 
given copy, paste and clear controls and the ability to show or hide all effects, create 
layers and control the global light.

Copy, Paste and Clear Layer Style

Selecting Copy Layer Style will copy all of the effects of the current layer, after which 
you can use the Paste Layer Style command to apply the same effects and blending 
options to one or more layers. The copy command can also be done by holding 
Option (Alt) while dragging the fx icon to a different layer; however, this will not copy 
any blending options.

Clear Layer Style allows you to remove all effects and blending options from the 
selected layer. Alternatively, if you’d like to remove only the effects, you can simply 
drag the fx icon to the trash can at the bottom of the Layers palette.

Show or Hide All Effects

Hide All Effects is an interesting option. It allows you to hide not only the effects on 
the selected layer but all of the effects in the document. This can be useful when
inspecting the core structure of a website and the styles have become distracting.
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Create Layers

The Create Layers command allows 
you to break styles into individual 
layers (right-click on a layer style list 
on the Layers palette and select 
Create Layers). But in doing so, you 
sacrifice the ability to edit them via 
the Layer Styles dialog. Certain layer 
styles will break when converted to 
layers, and some will need to be 
remasked. Breaking the style into 
layers can help you double up effects 
on the original layer (e.g. two strokes) 
or apply effects to effects themselves 
(e.g. strokes with strokes).

Global Light

If you’re applying a global light to your styles, you can quickly modify the angle and 
altitude from the Effects contextual menu.

Saving and Loading Styles
Once you’ve created a top-notch layer style, you’ll undoubtedly want to save it for 
later use. By clicking the New Style button in the Layer Style dialog, you can append 
your layer style to the current list of styles. You can even save the opacity, fill and 
other blending options by checking “Include Layer Blending Options.” After a style 
has been created, it can be accessed in a few places. In the Layer Style dialog, you 
can view and manage styles by clicking the Styles tab. There is also a Styles palette 
(Window → Styles) that gives you the same management control as the Layer Style 
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dialog. You might also want to preset a style before creating new shapes. This can be 
done in the Shape Tool’s properties bar using the Styles drop-down menu.

Building a library of commonly used layer styles can save you a lot of time and 
hassle, especially on large projects. It’s also a good idea to save your most commonly 
used styles in an ASL file, which can be shared across workstations. This can be done 
through either the Style tab in the Layer Style dialog or the Styles palette by 
selecting Save Styles from the flyout menu. You can then save a file that contains all 
of the styles currently in the list. In the same manner, you can load ASL files by 
choosing Load Styles from the flyout menu.

Quick Tips
0% fill

Whether you’re creating a transparent button, a simple border or anything else that 
calls for a layer style but not necessarily any layer data, a 0% fill can be extremely 
useful. Because you’re stripping away only the original layer data, your layer styles 
will display at their respective opacities — essentially creating an effects-only layer.
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Invisible Strokes

Invisible inner strokes come in handy when you need to shrink the content of a layer 
proportionately inward from its perimeter. For example, creating a rounded rectangle 
inside another rounded rectangle while keeping proportionately smaller corner radii 
can be rather difficult. By using the same corner radius as the larger rectangle and 
adding an inner stroke with the opacity set to 0%, you can simply ramp up the size of 
the stroke to reduce the radius until it’s perfectly in line.

Letterpress Type

A popular effect is simulated letterpress. By adding a white drop shadow with a size 
of 0, a distance of 1 and a blend mode set to Screen, you can create the effect of 
type (or any shape for that matter) being pressed into the background. Alternatively, 
if the background is a light shade, you can reverse the angle, change the color to 
black and change the blend mode to Multiply to create the same effect.
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Scaling Effects

There may be times when you’ve created a Layer Style that looks great at the original 
size, but when the shape is increased or decreased your beautiful style is destroyed. 
Fortunately, Photoshop provides a method for adjusting out-of-whack styles. Simply 
choose Layer → Layer Style → Scale Effects, and input the percentage to fit your 
needs.

Inconspicuous Menu Options and Spring-Loaded Tools

A number of hidden commands are available to you in the Layer Styles menu. 
Depending on the effect, you can gain access to either the Hand tool or the Move 
tool by simply mousing over the document window. The Hand tool allows you to 
move the document around just as it would outside of the Layer Styles menu, and 
the Move tool repositions the current effect and updates the settings automatically. 

When using the Move tool, you can still access the Hand tool by holding the space 
bar. While using either of the tools, you can zoom in and out by holding Command + 
Space (Control + Space) or Option + Space (Alt + Space), respectively. Finally, 
holding Option will change the Cancel button to a Reset button, allowing you to 
undo any changes.
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Chapter 4, Brushes 

Wabi-sabi is the traditional Japanese  
aesthetic of the imperfect. It promotes  
the beauty and humanness of worn,  
naturally aged objects. For example, the  
patina of an ancient bronze statue adds  
an appreciable imperfection. The implied 
history and naturalness add a sense of  
legitimacy and uniqueness that a new 
statue simply can’t provide.

Many websites today are like new  
statues, with perfectly polished design  
elements, crisp edges and geometric  
shapes. While this makes for clean, easy-
to-use interfaces, it can also create a  
rather cold user experience. Introducing  

some imperfect design elements can  
help cut through the stark precision and  
produce a wonderfully unique aesthetic.

Photoshop’s tools are designed to  
execute with absolute precision. The  
exception is the brush tool, which is  
capable of adding randomness and  
imperfection. Mastering the digital brush  
is by no means easy. It carries the same  
difficulties as the sable brush hidden at  
the bottom of your art bin. In fact, the  
difficulty is multiplied by the disconnect  
between the hand and monitor.  
Developing Photoshop brush skill takes  
time, but it is well worth the effort. 
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Basic Settings 
Along the brush’s properties bar are some simple yet powerful settings that 
determine the strength and shape of the brush. These settings have a big impact on 
the how the brush applies paint, so understanding them is important. 

Brush 

The brush menu, which is accessible by clicking the drop-down menu next to the 
brush preview or by right-clicking on the canvas, presents three options to control 
the shape of your brush: “Master Diameter,” “Hardness” and “Brush Shape.” 

The Master Diameter setting sets the 
overall width and height of your 
brush in pixels. While hard to notice 
on a standard round brush, making a 
brush larger than its original size can 
make it blurry. So, if you want to 
maintain clean edges, keep an eye on 
the brush’s original diameter. This 
setting is easily controlled using a 
couple of shortcuts. Use [ and ] to 
modify the diameter in increments of 
10 pixels, or use the on-canvas drag 
method: with your mouse cursor on 
the canvas, hold down Option + 
Control + Shift (Alt + Shift + Right-
click) and drag the mouse left or right. The brush will change in size as you scrub 
back and forth. This is great for when you need a precise size on the fly. 
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clicking on the canvas. 



The hardness setting is available only for Photoshop’s round brushes. Setting the 
hardness as a percentage from 0 to 100 will feather the edges of the brush: 100% is a 
crisp edge, and 0% is a completely feathered edge from the center of the brush to 
the circumference. For broad alterations to this setting, use the keyboard shortcuts 
Shift + ] and Shift + [ to change the values in 25% increments, or hold Command + 
Option + Control (Control + 
Alt + Right-click) and drag 
inside the canvas to change 
the values and see them take 
effect as you do it. 

At the bottom of the panel is 
an assortment of brush presets 
that gives you quick access to 
the brushes you use most. 
Some of the defaults are just 
simple shapes and textures, 
but others have been customized with advanced settings in the Brushes palette (F5). 
Photoshop has a number of brush libraries you can add to the list using the panel’s 
flyout menu, but you can also load and create custom brushes (see "Brush Presets" 
on page 59). 

Mode 

The brush’s mode sets how painted pixels affect those already on the current layer. 
These modes work the same way that Blend Modes work on the layer’s palette, 
except that they’re converted to absolute values when the stroke is finished. This is 
an important distinction to understand: once you’ve painted using a blending mode, 
that mode cannot be altered after the fact, because then you would be using 
blending modes on the layer’s palette. 
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The brush tool also introduces two blending modes not found in the layer’s palette: 
“Behind” and “Clear.” The Behind setting allows you to paint only in the areas of the 
layer that are transparent; this can be helpful if you need to paint behind a subject 
and leave filled pixels intact. The Clear setting essentially turns the brush into an 
eraser; instead of adding paint to the layer, it removes it. 
 

Smashing eBook Series: #3 | Mastering Photoshop for Web Design | 57

Chapter 4, Brushes 

 Setting the  
mode changes  
how the paint  

affects the  
layer’s current  

pixels.

The Behind  
mode allows  
you to paint  

strictly in  
transparent  
areas. Clear  

mode 
essentially turns  

the brush into  
an eraser.



Opacity, Flow and Airbrush 

These three settings work in unison to determine the amount of paint laid on the 
canvas. The opacity setting is the master control: it sets the maximum amount that 
can be painted with each stroke, mouse down to mouse up, regardless of any other 
setting. 

Flow, on the other hand, sets the amount of paint applied to an area every time the 
brush moves. So, if your Flow setting is set to 20%, and you click one area of the 
layer, only 20% will be painted. However, if you move the mouse back and forth over 
an area with the same setting, the paint will build up incrementally by 20%. 

Finally, the Airbrush setting allows you to add paint based on time instead of 
movement; by simply holding the mouse down in one area, you multiply the brush’s 
effect. You can quickly set the Opacity of a brush using the number keys (5 is 50%, 65 
is 65%). By holding Shift while inputing the numbers, you can control the brush’s Fill 
setting. Note: if the Airbrush setting is on, then these two shortcuts are reversed. 
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Advanced Settings 
On the Brushes palette (F5) are dozens of settings that control the way the brush 
paints, from shape and size to flow and scatter. Understanding how to use these 
options is the key to creating wonderful brushes. 

Brush Presets 

The Brush Presets menu lists 
all of the currently available 
brushes. While some of the 
presets simply change the 
shape of the brush, others 
have advanced settings. 

Photoshop has a number of 
brush libraries in addition to 
the defaults that can be 
easily appended to the 
current list of presets. These 
presets are accessible in the 
flyout menus located on the 
Brushes Palette and in the 
Brush drop-down menu in 
the toolbar. Photoshop 
provides a dozen or so 
libraries, including Dry 
Media, Wet Media, Natural 
and Calligraphic  but you 
can load a custom library by
choosing “Load Brushes.” 
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The brushes in the Brush Presets list are not just brush  
shapes: some also have advanced settings.



If you’ve created a brush that you would like to save as your own custom preset, you 
can do so by clicking the “Create New Brush” button at the bottom of the palette. 
This will add the brush to your preset menu; but if the menu is reset, the brush will 
be lost. Luckily, Photoshop allows you to export a custom library so that you never 
lose your favorite brushes. Simply choose “Save Brushes” from the fly-out menu, and 
then you can export an ABR file containing all of the brushes currently in the Brush 
Presets menu. 

You can customize even further by creating your own brush shape. To do so, start by 
selecting the area you’d like to create the brush sample from (or select the layer 
you’d like to use). Then, select Edit → Create Brush Preset. Name it and click OK. A 
new brush preset will be added to the menu. 

Brush Tip Shape 

This group allows you to control the primary shape of the brush. Many of these 
settings, which are outlined above, are also found in the Brushes toolbar, but here we 
also have options for flipping, rotation, roundness and spacing. Rotation, Flip X and 
Flip Y modify the orientation of the brush. Setting Roundness to lower than 100% 
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squishes the brush along its 
original x-axis; this can be 
used to easily create a
calligraphic brush. You can 
also control the values by 
dragging the arrow and 
control points on the image 
to the right. 

Photoshop scales brushes by 
interpolating them up or 
down; no vector brushes are 
available. Therefore, some 
brushes become gritty or 
pixelated if scaled too big. To 
quickly return a brush to its 
original size, click the “Use 
Sample Size” button. 

The final setting in this group 
is Spacing, which determines 
how often the brush is 
sampled onto the layer. Lower 
values place the samples close 
together, and higher values 
space them farther apart. 
Spacing not only changes the 
stroke’s appearance but can 
drastically affect Photoshop’s
performance. Setting it to 1% 
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can produce smoother edges, but a large or complex brush can seriously bog down 
Photoshop. If performance is an issue, keep this setting as high as possible. Spacing 
can also be turned off using the check box next to its name. This causes the brush to 
sample with inconsistent spacing based on the speed of your movements. 

Brush Control Methods 

A number of the settings in the Brushes palette allow you to set a method for 
controlling values. They include Off, Fade, Pen Pressure, Pen Tilt, Stylus Wheel, 
Rotation, Initial Direction and Direction. Some of these settings require a tablet, such 
as a Wacom. If you don’t have a tablet, or if the method is not available with your 
particular stylus, Photoshop will display an error icon to notify you. 

Off 

Control is completely 
negated with the Off setting, 
which means that values will 
remain consistent throughout 
the stroke of the brush.  
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Fade 

The Fade control allows you 
to specify the number of 
steps over which the setting 
will incrementally decrease 
until it reaches its minimum. 
So, by default, setting the 
Size control to Fade with 10 
steps will cause the brush to 
decrease its size by 10% each step until the brush reaches 0. This can be used with 
the Size setting to create individual strands of hair. While many of the settings allow 
you to specify the fade’s minimum percentage, some use a preset amount. For 
example, setting steps for the Angle Fade determines how many steps will be used 
to rotate the brush 360°. 
 
Pen Pressure 

Pen Pressure is an extremely 
useful setting but requires a 
pressure-sensitive tablet 
device. It determines values 
based on how hard you press 
the pen to the pad. This often 
makes for intuitive painting, 
especially when used on size 
and opacity settings. 

Pen Tilt 

The Pen Tilt setting changes values based on the angle of the pen to the tablet. 
When the pen is perfectly perpendicular to the tablet, the variance is set to 0%. As 
you tilt the pen, the values increase. This setting is especially helpful for controlling 
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the angle of the brush, 
because it also takes into 
consideration the direction in 
which the pen is pointing on 
the tablet. So, holding the pen 
at an angle and pointing it to 
the left of the tablet will point 
the brush to the left. 
 
Stylus Wheel 

If your stylus is equipped with 
a Stylus Wheel, you can use it 
to control variance on the fly 
by rotating it. This may be 
helpful for quickly changing 
settings between strokes, 
although using it to change 
values during a
stroke is difficult. 
 
Rotation

This is another setting that 
requires a special type of 
stylus. If your stylus supports 
Rotation, you can simply 
rotate the stylus to control 
values. This is probably best 
used with the angle setting. 
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By setting the Angle Control to Pen Tilt, you can match  
the brush tip’s rotation to your hand’s rotation.

 Stylus Wheel 

   Rotation



Initial Direction 

When using the Initial 
Direction setting, the brush 
will not immediately start 
applying paint. Photoshop 
waits to see in which direction 
you move the brush and then 
rotates the brush according to 
the angle.  

Direction 

The Direction setting can be 
particularly useful for painting 
things like grass along a 
contour, because it rotates 
based on the direction your 
brush has traveled since the 
last step. 

Shape Dynamics 

Now that you have set a basic 
shape and size, you can add 
some variance using Shape 
Dynamics. Here you’ll see 
three different types of jitters, 
which control the amount of 
variation allowed for size, 
angle and roundness. Setting 
any of these options to above 
0% will cause the brush to 
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sample at random values within the range set by the percentage (e.g. setting the 
Angle Jitter to 50% will limit the brush’s rotation to 180°). 

Scattering 

The Scattering menu allows 
you to vary where each 
sample of the brush is 
placed and how many 
samples are placed per step. 
Three sliders are here for you 
to control: Scatter, Count 
and Count Jitter.

The Scatter setting sets a 
percentage for how far off 
the origin the sample is 
allowed to travel. By default, 
this controls the variance 
only along the y-axis, but by 
clicking the "Both Axes" 
check box, you set the same 
value for the x-axis. 

Count and Count Jitter work 
together to determine how 
many samples are generated in every step. Count dictates the maximum number of 
samples allowed, while Count Jitter randomly chooses a number in that range to 
sample. If the Scatter setting is not set to above 0%, then the Count setting will place 
the brush on top of itself, which can create a “heavy” brush with jagged edges. 
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Texture 

Adding a texture to your brush can give a wonderful sense of depth. Photoshop 
allows you to apply any of your Texture presets to the brush. You can then modify 
the scale or invert it. The Mode drop-down menu provides a list of blending modes 
that determine how the texture mixes with the current values of the brush. Although 
most of these blending modes will look familiar to you, they function a little 
differently here. For example, you would think that setting the Mode to Multiply on a 
brush that is completely black wouldn’t have any effect. However, Photoshop 
compensates by reducing the original values of the brush so that the texture is 
visible. 

At first, the Depth setting 
seems to work by setting the 
opacity of the texture. But what 
it really does is ramp the values 
of the texture from their 
original grayscale values (at 
100%) to completely white 
(0%). This allows for more 
dramatic results than you 
would get by simply reducing 
the texture’s opacity. 

This menu also has a feature, 
called Texture Each Tip, that 
allows you to control the 
texture of every brush sample. 
Checking this option turns a 
couple of other sliders on that 
set the Minimum Depth and 
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Depth Jitter. Altering these values gives each sample a random depth within the set 
range. 

Dual Brush 

Combining two brushes using the Dual Brush option opens the door to some 
fantastic effects that you could never create with a single brush. As the name implies, 
this setting uses two different brush shapes to create the final sample. The primary 
brush is basically used as the mask that the dual brush is contained within. The Dual 
Brush menu has a few settings for the second brush that work in the same manner 
as the ones for the primary brush. The differences you set in Shape, Spacing, 
Scattering, Count and Mode make for a more dynamic and naturally random brush 
stroke. 
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Color Dynamics 

The Color Dynamics menu helps you inject some color variation into your brush 
strokes. You can control the colors by using the Foreground/Background Jitter, or 
you can allow Photoshop to randomly select values using the Hue, Saturation and 
Brightness Jitters. 

The Foreground / Background 
Jitter controls how much of the 
background color is allowed to 
be sampled into the brush. 
Note that the background color 
is added to (not substituted 
for) the foreground color. This means that if your foreground color is red and your 
background color is blue, the intermediary samples will be a purple hue. 

The Hue, Saturation and 
Brightness Jitters determine the 
maximum amount of variance 
allowed based on the 
foreground color’s values for 
each. So, if your foreground 
color has a saturation or 
brightness value of 0, then your 
brush strokes will be completely 
grayscale. At the other extreme, 
setting a foreground color to 
100% brightness and saturation 
will make every possible 
color available to use. 
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colors.



In addition to the Jitter settings 
is a Purity slider. This sets how 
pure the saturation is for each 
sample. If set to 0%, it does 
nothing; if moved to 100%, it 
limits the Saturation value for 
each sample to 100%. However, 
don’t mistake this for an 
overriding setting for saturation; 
it sets only thresholds for it. So, 
setting it to -50% ensures that 
saturation values never go 
above 50%, and a setting of 
-100% completely removes all 
saturation. 

Other Dynamics 

With the Other Dynamics 
menu, you can jitter and set 
controls to vary the brush’s 
opacity and flow. Both of these 
jitters depend on the brush’s 
current settings in the 
properties bar. They don’t allow 
the brush to gain opacity; they 
only determine how much 
lower it can go. The pen 
pressure control is an intuitive 
match for either of these 
settings. 
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Other Settings 
Noise 

This generates random noise 
within the gray values of your 
brush shape. 
 
Wet Edges 

This decreases the interior 
values of your brush, while 
leaving the edges at full opacity. 
In doing so, the brush creates 
an effect similar to watercolor, 
with its “wet” edges. 

Airbrush

This allows paint to build up incrementally based on the Flow setting and limited by 
the Opacity setting (see Opacity, Flow and Airbrush above). 

Smoothing

This setting smoothens the curves of the stroke to prevent polygonal curvatures. 
Turning this off might help if your brush is rendering slowly. 

Protect Texture

This ensures that the same texture is used for every brush with a texture. 

Other Palette Options 
Lock Setting

Next to each menu name in the Brushes Palette is a padlock icon. This allows you to 
lock settings so that when you switch to a different brush preset, the settings from 
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that menu carry over to the new preset. This is handy when you need a similar effect 
but don’t want to rebuild it with a new brush shape. 

Resetting

The Brushes Palette has two different ways to reset controls in its flyout menu: “Clear 
Brush Controls” and “Reset All Locked Settings.” Clear Brush Controls turns off all 
controls except for Smoothing, but keeps the locked settings locked. Reset All 
Locked Settings also turns off all controls but unlocks everything.

Quick Tips 

Learning the technical aspects of the digital brush is only the first step to becoming a 
master brush artist. A bit of talent mixed in with neverending practice are also 
required. Here are some quick tips to help you along the way. 

Changing the Cursor 

If the normal cursor isn’t to 
your liking, you can change it. 
In Photoshop’s Preferences 
menu (Command/Control + K) 
is a section called Cursors 
(Command/Control + 5). Here 
you have the option to change 
the "Painting Cursor" from 
Normal Brush Tip to Standard, 
Precise or Full-Size Brush Tip. 
You can also create a hybrid 
cursor by using the Normal or 
Full-Size Brush Tip in 
conjunction with the “Show 
Crosshair in Brush Tip” option.
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Below the Paint Cursors section is an option for the Brush Preview color. This is the 
color that is displayed when modifying the brush shape with the on-canvas drag 
shortcuts: Control + Option + Drag (Alt + Right-click + Drag) to change the 
diameter, and Control + Option + Command + Drag (Control + Alt + Right-click + 
Drag) to change the hardness. 

Painting Straight Lines 

Painting a freehand straight line is nearly impossible. Luckily, Photoshop has some 
features to help with this. By holding the Shift key while painting, your stroke will be 
constrained to 45° angles. Painting straight lines that aren’t locked to 45° angles is 
just as easy: click to start a line, and then Shift-click at another point, and you’ll get a 
perfectly straight line between the two points. 

Painting Perfect Curves 

Photoshop’s Paths palette allows you to stroke a path using the current brush’s 
settings. This can be extremely helpful if you have a tricky curve or complex shape to 
paint. 
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First, set up your brush. Then, select 
the path you wish to stroke; and in the 
Paths palette, Option-click the Stroke 
path with the brush button. This will 
present you with a dialog box that 
allows you to set the tool to stroke 
with. You can even use the Simulate 
Pressure button to activate any control 
methods you have set on your brush. 

Other “Painting” Tools 

Remember that the Brush Tool is not the only tool that uses brush settings. By 
customizing other tools, you can create some very impressive effects. The other 
“Painting” tools include the following: Pencil, Eraser, Background Eraser, Clone Stamp, 
Pattern Stamp, Healing Brush, History Brush, Art History Brush, Smudge, Blur, 
Sharpen, Dodge, Burn, Sponge, Color Replacement and Quick Selection. 

Keyboard Shortcuts 

B Brush tool 

Shift + B
Rotate through Brush tools 
(i.e. Brush, Pencil and Color Replacement tools) 

F5 Show or hide Brushes palette
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Brush Settings 

[ Decrease brush diameter 

] Increase brush diameter 

Shift + [ Decrease brush hardness by 25% 

Shift + ] Increase brush hardness by 25% 

Digit combination (with airbrush off) Set the brush’s opacity 

Shift + Digit combination (with airbrush off) Set the brush’s fill 

Digit combination (with airbrush on) Set the brush’s fill 

Shift + Digit combination (with airbrush on) Set the brush’s opacity 

Option + Shift + “+” (Alt + Shift + “+”) Next blending mode 

Option + Shift + “-” (Alt + Shift + “-”) Previous blending mode 

“,” Previous brush 

“.” Next brush 

Shift + “,” First brush 

Shift + “.” Last brush 

Caps lock
Toggles between Precise and 
Normal cursors 

Control + Click (Right-click) inside canvas Bring up the quick brush menu 

Control + Shift + Click (Shift + Right-click) 
inside canvas

Brush blending mode menu 

Control + Option + Drag (Alt + Right-click 
drag) inside canvas

Change the brush’s diameter 
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Control + Option + Command + Drag 
(Control + Alt + Right-click drag) inside 
canvas

Change the brush’s hardness

Painting 

Shift + Drag Constrain the brush to 45° 

Click, move cursor, then Shift + Click
Draw a straight line from the first click to 
the second click

Helper Tools 

Option (Alt) Temporarily switch to Eyedropper tool 

Shift + Option (Shift + Alt) Temporarily switch to Color Sampler tool 

Command (Control) Temporarily switch to Move tool 

Command + Option (Control + Alt) Duplicate and Drag layer 

Space Temporarily switch to Hand tool
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Chapter 5, Typography 

Words may be clear and concise, but  
typography is the voice that carries them into  
our subconscious. Typography has the ability to  
evoke feelings and forge impressions greater  
than the words it renders. Even bad typography  
can be extremely powerful. We’ve all landed on  
websites with bright red text on an even  
brighter blue background, and strained our  
eyes to read three paragraphs over minutes 
that we wished we could take back. 

Poor type can instantly ruin a visitor’s  
impression of your brand and its reputability.  
So, understanding the ins and outs of on-screen  
typography is critical. While the majority of  
type on the Web is rendered by HTML,  
Photoshop is still necessary to handle treatment  
beyond the grasp of CSS. In this chapter, we’ll  
explore Photoshop’s type tools and discover  
ways to maximize the software’s typesetting  
capabilities.
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Anatomy of the Type Tool
Photoshop’s Type Tool is pretty 
straightforward. Click inside the 
document and you can add a 
type layer, which is referred to as 
a Point Text layer. Clicking and 
dragging creates a Paragraph Text 
layer. You can even click on or 
within a path to create a Type 
Path. These implementations are 
very similar but have some 
important distinctions.

Point Text

Point Text layers specify a single 
point from which the first baseline 
of the text is set. The text flows 
from this point on towards infinity 
unless manual line breaks are 
entered. This restricts some of the paragraph options but makes this type of layer 
great for creating text for buttons and headlines (i.e. text with few characters). In fact, 
the open nature of a Point Text layer makes it much easier to use in these 
circumstances. Fumbling around with the size of a Paragraph Text layer to change 
the text on a button can be a real hassle.

Paragraph Text

By specifying a set area for the text to flow within, Paragraph Text allows more 
advanced settings, such as word wrapping and hanging punctuation. These 
advanced paragraph options are essential when setting larger blocks of text.
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Type Paths

There are two ways paths can be used with the type tool: by defining the baseline or 
by creating a custom text box shape. Select the Work Path you’d like to use, and with 
the Type Tool, mouse over the path. The dotted square on the cursor will change 
from a square to a curved line. Click on the path and you’ll see that the type flows 
right along the path.

After committing the type (Command/Control + Enter), you can use the Path 
Selection Tool to move the beginning and end points — indicated with an “x” and 
black circle, respectively — or flip the type from the top of the line to the bottom. If 
using a closed path, you can click inside it to create a custom-shaped text box.

Aside: Warping Text

Warp Text is reminiscent of Microsoft’s WordArt because it allows you to bend, bulge 
and skew text in all sorts of ridiculous ways. I recommend steering clear of these 
options because they will give your text a less than professional feel. Nonetheless, 
you can access the Warp Text dialog in the Text Tool’s properties bar. Choose from a 
number of different styles, and set the amount of bend and distortion. Again, 
though, even if you want to just wrap text around a simple shape, you’re better off 
using a type path.

Character Palette 
The Character palette is sort of like a wolf in sheep’s clothing. It provides everything 
you need to properly change the appearance of type, but it also has options that 
should never appear in software for creative professionals. Understanding how and 
how not to use this palette is extremely important to setting type.
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Font 
Anyone who has used a word 
processing program should be 
pretty familiar with the first few 
options in the palette. The very 
first is the font family, which, 
when expanded, displays a list 
of all fonts available in the 
system. 

After you have chosen a font, 
the drop-down menu next to it 
will provide a list of all of the 
font’s variants. This may include 
obliques, headlines, various 
weights, glyph sets, extended 
and condensed versions and more.
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Size and Spacing 
Just below the font drop-down menus are four settings for controlling the size and 
spacing of the type. The first setting is the size of the font, set in points, which varies 
greatly from pixels. Next to it is the leading, which sets the distance between 
baselines, in points as well.

Third, we have kerning, which controls the spacing between two characters. To kern 
two characters, place the cursor between them, and then modify the kerning value to 
bring the characters closer or move them farther apart. If you select multiple 
characters or simply select the entire block of text, you can set the auto-kerning to 

either Metric or Optical. Metric kerning 
evaluates the absolute space between 
characters, with no consideration for 
individual character shapes. Optical 
kerning accounts for how the characters 
actually look (e.g. a capital “V” will be 
kerned closer to a lowercase “g”).

The final option in this set is tracking. 
Like kerning, tracking controls the space 
between characters, but for multiple 
characters. This should be used to space 
an entire block of text, as opposed to 
individual characters. 

Color, Baseline Shift and Stretching 
The next set of options contains two useful and two absurd ones. We’ll start with the 
options you should actually use. The Color option allows you to modify the color of 
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Optical kerning intelligently spaces letterforms,  
which is usually preferable to setting the  
kerning to 0 or using Metric kerning.



the selected text. To the left of it is the baseline shift, which translates characters up 
or down from the baseline. The other two options in this section allow you to stretch 
text to make it taller or wider. As a rule, avoid these two options. Stretched type just 
looks bad. 

Fauxs and Variants 
Under the guise of simplicity, Adobe has added a series of icons that give you quick 
access to common typesetting features. A couple of them are rather helpful, but 
most of them attempt to invent new characters for you. The All Caps option is the 
safest of the bunch; it simply replaces all lowercase letters with their capital 
equivalents. The Underline and Strikethrough options are also fairly safe, though you 
can achieve better results by drawing the line as a separate shape layer, thus 
avoiding intersecting the descenders.

The remaining options are ones that anyone who is serious about typography should 
avoid. These offenders are Faux Bold, Faux Italic, Superscript, Subscript and Small 
Caps. By running preset calculations on the text, these options bloat, skew and resize 
your type to simulate a different font variant. These faux variants look awkward and 
can be easily spotted, especially Small Caps, which simply changes the point size of 
the characters, leaving you with noticeably different weights. 
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inferior letterforms  
for the sake of  
simplicity.  Stick  
with true italics for  
better typography.



The Superscript and Subscript options work the same way. While somewhat 
conspicuous, superscript and subscript characters are usually included in the font set. 
I recommend using Illustrator’s Glyph palette to hunt down the elusive characters. If 
you need bold, italics or small caps, check the font variant drop-down menu. If no 
such variant exists, then check with the type foundry to see if it is available. If no 
variant is available, you’re probably best off choosing a different font. 

Anti-Aliasing 
Anti-Aliasing is critical to the appearance of on-screen typography. It basically 
smoothens the edges of characters to preserve their original design. Photoshop 
provides five preset anti-alias settings, which determine pixel values using various 
algorithms in conjunction with the document’s pixel grid. Unfortunately, none of 
these settings allow for subpixel rendering, but by using the Free Transform option 
to nudge the layer’s position, you can effectively force the algorithms into rendering 
more cleanly. Each setting allows a different amount of origins, and some only 
produce variations when translated along the x-axis. Below is a table of available 
transformations.
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Using the Free Transform tool allows you to nudge type layers to improve  
the anti-aliasing.



Faux Italics uses inferior  
letterforms for the sake of  
simplicity. Stick with true italics for  
better typography.

Aside: Subpixel Rendering

Every pixel on a standard monitor consists of three components: a red, a green and a 
blue. The brightness of each of these subpixels is controlled independently, and 
because of their small size, our eyes blend the three into one solid-colored pixel. 
Typical anti-aliasing sets even values for each of these subpixels, resulting in full 
grayscale pixels. 

Subpixel rendering exploits the individuality of each single-colored component and 
uses it to increase the perceived resolution of the monitor. This allows a pixel to take 
on visual weight from neighboring pixels, thereby allowing type to be smoothed in 
smaller increments. The only drawback is that rendering type in this way can produce 
subtle color shifts visible along the edges of glyphs. Unfortunately, Photoshop does 
not support subpixel rendering at this time, but it certainly gives us something to 
hope for. 
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Subpixel Rendering  
renders type more  
smoothly by  
increasing the  
perceived resolution  
of a device.  
Unfortunately,  
Photoshop does not  
currently support it. 



None 

Aliased text created using the None setting has 
very limited use and typically looks best 
between point sizes of 9 and 18. Sizes below 
this range will result in unidentifiable characters, 
and larger sizes will lead to increased character 
weight and overly jagged edges. 

Depending on the font, sometimes two different point sizes will render at the same 
height, causing a shift in letter spacing, width and x-height. For example, 14 pt Arial 
renders 10 pixels high with an x-height of 8 pixels. Arial at 13 pts also sits 10 pixels 
high but has an x-height of only 7 pixels — a slight but very perceivable difference. 
When tightly tracked, this setting might also require manual kerning, because some 
letters will sit pixel to pixel against each other. 

Sharp 

The Sharp setting uses very tight grid-fitting 
and produces sharp, if not too sharp, type. 
The plotting of pixels with this setting is very 
similar to how the None setting plots them, 
but it allows for a certain degree of 
smoothing. In fact, if you set these two 
options atop one another, you can actually 
see that a majority of solid pixels carry over 
from None to Sharp.
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Arial render with  
the same cap  
height but  
different x-heights.



While the cap height and x-height typically remain the same, you might see an 
increase in character weight and width. Sharp has a tendency to completely cut 
subtle shape variations from rendering and sometimes causes inconsistent 
letterforms. So, if typeface integrity is important to you, you may want to try a 
different setting.

Crisp 

The Crisp setting maintains much of the font’s 
original weight and curvature but cleans up 
some of the awkward pixels created by light 
serifs and thin strokes, which is especially useful 
for larger point sizes. With the Crisp setting, 
however, you sacrifice the ability to nudge the 
layer on the y-axis.

Strong 

The Strong setting is notorious for adding 
unnecessary weight to a typeface, but it 
provides the most freedom with translating the 
origin, with 32 x-axis variations and 16 on the y-
axis. The variety of origins with this setting 
comes in handy when working with complex 
letterforms. Strong is also useful when working 
with typefaces that have very thin strokes.

Smooth 

The Smooth setting is the closest to unhinted 
anti-aliasing and therefore remains truest to the 
original glyph shape. This algorithm is best used 
on medium-sized to large type, because it tends 
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to render very light and often blurry at smaller point sizes. If used with an 
appropriate typeface at a proper size and if the origin is properly adjusted, this 
setting can strike a beautiful balance between crispness and letterform fidelity.

Flyout options 
Change Text Orientation 

This option allows you to toggle the type layer between a vertical and horizontal 
layout.

Standard Vertical Roman Alignment

If your type layer is set to vertical 
orientation, then your text will stack 
character on top of character. 
However, if you turn the Standard 
Vertical Roman Alignment option off, 
then the text will align characters 
along the same baseline but rotate 
them 90°.
 
OpenType 

Depending on the font, a number of 
OpenType features might be 
available. These can really improve 
your typography by giving you 
access to more appropriate glyphs 
and creative alternatives. Many of 
these features should be set only on 
the necessary characters to avoid 
strange formatting.
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Standard Ligatures: replaces common character combinations with a single 
combined glyph.

 

Contextual Alternates: changes characters based on the characters around them to 
increase fluidity.
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Adobe Garamond 
Pro Italic with and  
without the  
standard "th" and 
"ffi" ligatures.

 

Bickham Script Pro  
has many contextual  
alternates, as seen  
above.



Discretionary Ligatures: replaces character combinations in the font’s discretionary 
ligature table with a single combined glyph. 

 
Swash: swaps capital characters with more decorative swash alternatives.

Old Style: switches lining figures with old-style figures. 
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Adobe 
Garamond 
Pro’s  
discretionary  
“st” ligature. 

 

Bickham Script  
Pro has  
extraordinary  
swashes.

Goudy Old Style  
and its old-style  
figures align  
better with  
lowercase text.



Adobe 
Garamond 
Pro set to  
ornaments.

Stylistic Alternates: substitutes decorative alternatives for standard characters.

Titling Alternates: substitutes more appropriate glyphs for use with large type sizes.

Ornaments: changes certain characters with glyphs from the ornament set. 
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Bickham Script  
Pro with stylistic  
alternates for  
the “B” and “k.”

Didot LT Std  
Headling with  
titling alternates  
(bottom) has  
subtle differences  
in weight and 
spacing, making  
it better suited to  
headlines.



Adobe 
Garamond Pro  
properly  
displays a  
fraction with a  
solidus instead  
of a backslash.

Ordinals: swaps character combinations such as “st,” “nd” and “rd” for use with “1st,” 
“2nd” and “3rd.”

 Fractions: change digits separated by a backslash (/) with their numerator or 
denominator alternatives and replaces the backslash with a solidus. 

Fractional Widths

This setting can sometimes help with anti-aliasing and kerning type, especially at 
small point sizes. With this setting turned on, character spacing is set to varying 
fractions of pixels. This is ideal for auto-kerned type at large sizes, but it tends to 
bump the type either too close together or too far apart at smaller sizes. Turning this 
option off rounds all character spacing to whole pixel values, which might better 
space the problematic type. This is hit or miss, so use it wisely.
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rankings. 



System Layout 

System Layout resets certain options in the Character palette to simulate the generic 
typesetting of a plain text document. Kerning and tracking return to 0, the anti-alias 
setting is changed to None, and Fractional Widths are turned off.

No Break 

No Break gives you manual control over which words hyphenate in a paragraph text 
layer. By selecting a word and setting No Break, you ensure that the word will never 
be hyphenated. You can also do this with multiple words to always keep a phrase on 
the same line. If you don’t mind the word being hypenated but you have a 
preference for where the hyphenation should occur, then select the characters that 
should not be broken and set No Break, which will create a break elsewhere.

Reset Character 

The Reset Character option returns the text to its original default settings. Font, size, 
leading, color and everything else in the Character palette will be reset.

Paragraph Palette 
The Paragraph palette relates mainly to margins and justification. These settings are 
most useful when setting large blocks of text with a paragraph text layer, but they 
can also be used with point text layers.

Justification

Photoshop provides seven different justification settings: three ragged and four 
flush. The first three are your basic ragged settings: left-aligned, centered and right-
aligned. They are available for both point text and paragraph text, and they simply 
determine how each line of text in a paragraph is aligned. If set, hyphenation is still 
applied, but without justification. The other four settings — Justify Last Left, Justify 

Smashing eBook Series: #3 | Mastering Photoshop for Web Design | 92

Chapter 5, Typography 



Last Centered, Justify Last Right 
and Justify All — are available 
only with paragraph text and 
space text so that both the left 
and right edges are flush.

The justification settings can be 
further controlled via the 
Justification setting in the 
Paragraph palette’s flyout 
menu. This dialog allows you to 
set thresholds and an optimal 
setting for how the text 
composer spaces characters or 
adjusts their width. Achieving 
an evenly colored block of text 
is the ultimate goal here, but 
keep the ranges as low as 
possible and use glyph scaling 
only when absolutely necessary.

Word Spacing: sets the spacing between full words. 80%, 100% and 120% are typical 
settings; going much further beyond these could result in inconsistent spacing. 
Instead of increasing the range, try adding letter spacing.

Letter Spacing: controls the amount of space added between individual characters. 
This can reduce gaping spaces but should be used in moderation (±5% or so).

Glyph Scaling: horizontally scales glyphs to add to or subtract from the length of the 
line. This should be used as little as possible (no more than about ±2%).
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Optimal justification spreads text evenly across the  
column, resulting in a block that colors the page  
consistently. Poorly justified text allows words to run  
together and spreads letters too far apart.



Auto Leading: sets the amount of leading applied when the Leading option in the 
Character palette is set to Auto. 

Hyphenation

The hyphenation option, which is on by default, breaks up words at the end of a line 
to aid justification and balance rags. You can modify the hyphenation settings with 
the Hyphenation option in the Paragraph palette’s flyout menu.

Words Longer Than: sets the minimum number of letters a word must contain to be 
hyphenated. Using a minimum of five is a good rule of thumb.

After First: controls the minimum 
of letters left behind the hyphen. 
Two definitely should be the 
minimum for this.

Before Last: controls the 
minimum number of letters to 
be carried over to the next line. 
Three is a safe minimum here. 
With a five-letter word, leaving 
two behind and carrying over 
three is accepted style.

Hyphen Limit: dictates the maximum number of consecutive hyphens allowed. Avoid 
more than three.

Hyphenation Zone: specifies a distance from the right edge of a paragraph within 
which no hyphenation should occur.
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Hyphenation can improve justification but should  
not be overused, as it is above.



Hyphenate Capitalized Words: enables or disables hyphenation of capitalized words. 
In general, avoid hyphenating proper nouns. 

Indents

There are three indenting options in the Paragraph palette: Indent Left Margin, 
Indent Right Margin and Indent First Line. The ones for the left and right margins 
allow you to inset a paragraph from its left or right bounds. This is helpful for 
blockquotes, lists and other non-standard paragraphs. The Indent First Line option 
indents only the first line of every paragraph.

If no extra space separates your paragraphs, the Indent First Line option can be used 
to add an appropriate pause between paragraphs. All of the indenting options also 
allow negative values; you can easily outdent a paragraph or create nicely aligned 
lists by setting a positive left indent and a negative first-line indent.
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A left-margin  
indent coupled  
with a negative  

first-line indent is  
great for aligning  
bulleted lists with  
multi-line items.



Spacing

Spacing paragraphs by adding a hard return in the text is bad style. If you’re familiar 
with HTML, it’s like adding a <br /> between <p> tags instead of using CSS to space 
paragraphs. It not only adds unnecessary data to the text, but makes controlling the 
space between paragraphs much more difficult. The spacing options in the 
Paragraph palette make this task much easier and more flexible.

Every-Line Composer vs. Single-Line Composer

The line breaks and hyphenation of paragraph text layers are determined by what’s 
referred to as a “composer.” Each paragraph is controlled by either the Every-Line 
Composer or the Single-Line Composer. They evaluate the character settings along 
with the justification and hyphenation thresholds to determine the best place to 
break lines. The Every-Line Composer analyzes every line in a paragraph to reduce 
the number of line breaks, while the Single-Line Composer works line by line and 
makes each as long as possible. The composer can be changed per paragraph by 
setting the cursor in the target paragraph and selecting either Every-Line Composer 
or Single-Line Composer from the Paragraph palette’s flyout menu.
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The spacing 
options give  
you much 
better control  
over the  
relationship  
between 
paragraphs  
and headlines.



Roman Hanging Punctuation

Hanging punctuation is good typography. It entails extending punctuation 
(quotation marks, periods, commas, etc.) at the beginnings and ends of lines into the 
margins.

Because the visual weight of punctuation is typically light, this setting improves the 
flush alignment of paragraphs. Photoshop will automatically hang punctuation when 
you enable Roman Hanging Punctuation in the flyout menu of the Paragraph palette.

Quick Tips 
Decimal Point Sizes for Improved Anti-Aliasing

Typophiles might cringe at the idea of using a decimal point size, but when 
designing for digital media, standard point sizes don’t always conform to the pixel 
grid. By using decimal point sizes and either the Smooth or Strong anti-alias setting, 
you can usually bring a blurry typeface back into focus.  
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improves the  
alignment of  

multi-line text  
blocks.



Shape Layer Anti-Aliasing

If Photoshop’s hinted algorithms are producing undesirable results, you may want to 
attempt using unhinted anti-aliasing by way of converting the type into a shape 
layer. This gives you access to the original outlines of the font, which draw values 
based on the percentage of the pixel enclosed in the shape. What you sacrifice in 
editable type you make up for in origin transformations: 32 on both the x-axis and y-
axis. While it’s usually a last resort, don’t rule out the possibility of using a Shape 
Layer: it can often produce better results than Photoshop’s algorithms.

Smart Quotes

Smart Quotes are good style and 
should be used instead of straight 
quotes wherever available. Luckily, 
Photoshop allows you to replace 
dumb quotes automatically. Open 
the Preferences dialog (Command/ 
Control + K) and navigate to the 
Type section. 
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Using decimal  
values can 
dramatically  
improve anti-
aliasing results, as  
seen above. Top: 16  
pt Goudy Oldstyle  
with Strong Anti-
Aliasing. Bottom:  
16.5 pt Goudy 
Oldstyle with Strong  
Anti-Aliasing.



You should see a few options, the first of which is Use Smart Quotes. Check this; now, 
any time you type a quote or apostrophe, it will be replaced with its smart 
equivalent. Note: some fonts do not have smart quotes. 

Hard Returns vs. Soft Returns vs. Paragraph Spacing

Separating lines of text is a pretty common task, but separating them properly goes 
beyond hitting the Return key. When you press Return, a hard return is inserted in 
the text. This signifies the end of a paragraph and should be used as such. Despite 
common practice, entering two hard returns after a paragraph is not the ideal way to 
space paragraphs. Rather, you can save data and make paragraph spacing much 
more flexible by making one hard return and modifying the Add Space After 
Paragraph option in the Paragraph palette. Doing so gives all hard returns the 
specified amount of spacing.

Of course, this can be a hassle when setting something like a postal address, which 
has multiple lines but is essentially a single paragraph. This is where soft returns 
come in. By pressing Shift + Return, you add a soft return. This does not register the 
end of a paragraph but instead allows you to control where your lines break in the 
paragraph.

Extra Glyphs

Each font typically contains a variety of glyphs that go beyond the standard set. 
Some of these glyphs are accessible by activating certain OpenType features, but a 
lot of them aren’t. If you happen to own Adobe Illustrator, you can use its wonderful 
Glyphs palette to view all of the extra glyphs that you don’t have direct access to. 
You can then copy and paste them into a Photoshop text area. 

If you don’t have access to Illustrator, you can use a system application to browse 
glyphs. In OS X, activate the character palette from System Preferences → 
International. Then, open the Characters dialog and change the View to Glyph.

Smashing eBook Series: #3 | Mastering Photoshop for Web Design | 99

Chapter 5, Typography 



You now have access to the glyphs of all installed fonts, and you can insert one into 
the active text field by double-clicking it. If you’re on a Windows machine, you can 
access a similar menu by opening the Character Map (Start → Applications → System 
Tools → Character Map).

Glyph Shortcuts

Special Characters

–    En dash Option + -               Alt + 0150

 —    Em dash    Option + Shift + -  Alt + 0151

™   Trademark   Option + 2             Alt + 0153

®    Registered  Option + R          Alt + 0174

©    Copyright    Option + G          Alt + 0169

§    Section          Option + 6           Alt + 0167

¶    Pilcrow      Option + 7               Alt + 0182

•    Bullet         Option + 8         Alt + 0149

…    Ellipsis       Option + ;               Alt + 0133

†    Dagger       Option + T             Alt + 0134

‡    Double dagger Option + Shift + 7 Alt + 0135

¡    Inverted Exclamation Option + 1      Alt + 0161

¿    Inverted Question     Option + ?      Alt + 0191

ª    Feminine Ordinal      Option + 9       Alt + 0170

º    Masculine Ordinal    Option + 0     Alt + 0186
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¦    Broken bar                     Alt + 0166

Dipthongs

Æ    AE    Option + Shift + ‘  Alt + 0198

æ    ae    Option + ‘              Alt + 0230

�   OE      Option + Shift + Q Alt + 0140

œ    oe     Option + Q         Alt + 0156

Ligatures

fi    fi      Option + Shift + 5

fl    fl      Option + Shift + 6

ß    Eszett (German double s)    Option + S

Diacritics

´   Add acute     Option + E, character to add to

ˆ    Add circumflex  Option + I, character to add to

¨    Add diaeresis     Option + U, character to add to

`    Add grave      Option + `, character to add to

˜    Add tilde      Option + N, character to add to

´    Acute   Option + Shift + E    Alt + 0180

˘    Breve    Option + Shift + > 
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ˆ    Circumflex Option + Shift + I   Alt + 0136

ˇ    Caron         Option + Shift + T

ı    Dotless I      Option + Shift + B

¨    Diaeresis      Option + Shift + U  Alt + 0168

`    Grave      Option + Shift + `

¯    Macron   Option + Shift + <  Alt + 0175

˙    Overdot    Option + H

˚    Ring       Option + K

˜    Tilde      Option + Shift + N      Alt + 0152

¸    Cedilla    Option + Shift + Z   Alt + 0184

˛    Ogonek   Option + Shift + X 

Å    A ring     Option + Shift + A       Alt + 0197

å    a ring      Option + A                    Alt + 0229

Á    A acute   Option + Shift + Y      Alt + 0193

á    a acute    Option + E, a               Alt + 0225

Â    A circumflex Option + Shift + M Alt + 0194

â    a circumflex   Option + I, a           Alt + 0226

Ä    A diaeresis    Option + U, A       Alt + 0196

ä    a diaeresis     Option + U, a        Alt + 0228

Ã    A tilde     Option + N, A            Alt + 0195
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ã    a tilde      Option + N, a             Alt + 0227

À    A grave    Option + `, A           Alt + 0192

à    a grave      Option + `, a              Alt + 0224

Ç    C cedilla     Option + Shift + C   Alt + 0199

ç    c cedilla      Option + C     Alt + 0231

È    E grave       Option + `, E   Alt + 0200

è    e grave       Option + `, e  Alt + 0232

É    E acute       Option + E, E Alt + 0201

é    e acute     Option + E, e         Alt + 0233

Ê    E circumflex  Option + I, E       Alt + 0202

ê    e circumflex Option + I, e        Alt + 0234

Ë    E diaeresis   Option + U, E        Alt + 0203

ë    e diaeresis Option + U, e        Alt + 0235

Í    I acute     Option + Shift + S    Alt + 0205

í    i acute      Option + E, i             Alt + 0237

Î    I circumflex  Option + Shift + D  Alt + 0206

î    i circumflex   Option + I, i             Alt + 0238

Ï    I diaeresis     Option + Shift + F  Alt + 0207

ï    i diaeresis    Option + U, i     Alt + 0239

Ì    I grave     Option + `, I            Alt + 0204

ì    i grave       Option + `, I           Alt + 0236
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Ñ    N tilde    Option + N, N        Alt + 0209

Ø    O slash      Option + Shift + O   Alt + 0216

ø    o slash      Option + o               Alt + 0248

Ó    O acute     Option + Shift + H    Alt + 0211

ó    o acute     Option + E, o           Alt + 0243

Ô    O circumflex  Option + Shift + J  Alt + 0212

ô    o circumflex  Option + I, o        Alt + 0244

Ö    O diaeresis  Option + U, O        Alt + 0214

ö    o diaeresis  Option + U, o           Alt + 0246

Ò    O Grave     Option + Shift + L    Alt + 0210

ò    o grave      Option + `, o          Alt + 0242

Õ    O tilde      Option + N, O         Alt + 0213

õ    o tilde      Option + N, o          Alt + 0245

Ú    U acute      Option + Shift + ;    Alt + 0218

ú    u acute      Option + E, u        Alt + 0250

Ù    U grave    Option + `, U        Alt + 0217

ù    u grave    Option + `, u          Alt + 0249

Û    U circumflex  Option + I, U      Alt + 0219

û    u circumflex  Option + I, u    Alt + 0251

Ü    U diaeresis    Option + U, U  Alt + 0220

ü    u diaeresis      Option + U, u  Alt + 0252
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Y    Y acute             Alt + 0221

y    y acute               Alt + 0253

ÿ    y diaeresis  Option + U, y Alt + 0255

Quotations

‘    Left single    Option + ]                Alt + 0145

’    Right single  Option + Shift + ] Alt + 0146

“    Left double   Option + [      Alt + 0147

”    Right double  Option + Shift + [    Alt + 0148

«    Left guillemet   Option + \             Alt + 0171

»    Right guillemet   Option + Shift + \             Alt + 0187

‹    Single left guillemet   Option + Shift + 3      Alt + 0139

›    Single right guillemet   Option + Shift + 4    Alt + 0155

˝    Double prime   Option + Shift + G

Mathematics

∞    Infinity    Option + 5

≠    Not equal  Option + =

±    Plus/minus  Option + Shift + =    Alt + 0177

⁄    Solidus      Option + Shift + 1

⁄    Create fraction   numerator, Option + Shift + 1, 
denominator
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≈    Approximately    Option + X

°    Degree     Option + Shift + 8        Alt + 0176

×    Multiplied by  Alt + 0215

÷    Divided by      Option + /  Alt + 0247

≥    Greater than or equal 
to      

Option + >

≤    Less than or equal to   
 

Option + <

∫    Integral      Option + B

¬    Negation    Option + L    Alt + 0172

◊    Lozenge     Option + Shift + V

µ    Micro      Option + M        Alt + 0181

π    Pi      Option + P

√    Square root   Option + V

·    Middle dot     Option + Shift + 9   Alt + 0183

∂    Partial differential  Option + D

‰    Per mille    Option + Shift + R  Alt + 0137

¹    Superscript 1       Alt + 0185

²    Superscript 2        Alt + 0178

³    Superscript 3         Alt + 0179

¼    One quarter     1, Option + Shift + 1, 4     Alt + 0188

½    One half       1, Option + Shift + 1, 2          Alt + 0189
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¾    Three quarters   3, Option + Shift + 1, 4  Alt + 0190

Currency

¤    Currency                          Alt + 0164

£    Pound    Option + 3      Alt + 0163

¢    Cent      Option + 4          Alt + 0162

€    Euro     Option + Shift + 2  Alt + 0128

ƒ    Florin  Option + F                

¥    Yen     Option + Y         Alt + 0165

Greek

∆    Delta  Option + J

∑    Sigma  Option + W

Ω    Omega  Option + Z

π    pi          Option + P

∏    Pi          Option + Shift + P

Keyboard Shortcuts

Command + H (Control + H) Hide or show text selection

Enter or Command + Return (Control 
+ Return)

Commit changes

Esc Discard changes
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Option + Delete (Alt + Backspace) Change text color to Foreground color

Command + Delete (Control + 
Backspace)

Change text color to Background color

Return Insert hard return

Shift + Return Insert soft return

Variants

Command + Shift + B (Control + Shift + B) Bold

Command + Shift + I (Control + Shift + I) Italic

Command + Shift + «+» (Control + Shift + «+») Superscript

Command + Shift + «-» (Control + Shift + «-») Subscript

Command + Shift + K (Control + Shift + K) All Caps

Command + Shift + H (Control + Shift + H) Small Caps

Command + Shift + U (Control + Shift + U) Underline

Command + Shift + ? (Control + Shift + ?) Strikethrough

Justification

Command + Shift + L (Control + Shift + L) Left align

Command + Shift + C (Control + Shift + C) Center align

Command + Shift + R (Control + Shift + R) Right align

Command + Shift + J (Control + Shift + J) Justify last left

Command + Shift + F (Control + Shift + F) Justify all
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Spacing and Sizing

Command + Shift + < (Control + Shift + <) Decrease type size by 2 pts

Command + Shift + > (Control + Shift + >) Increase type size by 2 pts

Command + Option + Shift + < (Control + Alt + 
Shift + <)

Decrease type size by 10 pts

Command + Option + Shift + > (Control + Alt + 
Shift + <)

Increase type size by 10 pts

Option + Up arrow (Alt + Up arrow) Increase leading by 2 pts

Option + Up arrow (Alt + Up arrow) Decrease leading by 2 pts

Command + Option + Up arrow (Control + Alt + 
Up arrow)

Increase leading by 10 pts

Command + Option + Up arrow (Control + Alt + 
Up arrow)

Decrease leading by 10 pts

Option + Left arrow (Alt + Left arrow) Kern or track -20 units

Option + Right arrow (Alt + Right arrow) Kern or track +20 units

Command + Option + Left arrow (Control + Alt 
+ Left arrow)

Kern or track -100 units

Command + Option + Right arrow (Control + Alt 
+ Right arrow)

Kern or track +100 units

Option + Shift + Up arrow (Alt + Shift + Up 
arrow)

Shift baseline +2 pts

Option + Shift + Down arrow (Alt + Shift + 
Down arrow)

Shift baseline -2 pts

Command + Option + Shift + Up arrow (Control Shift baseline +10 pts
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+ Alt + Shift + Up arrow)

Command + Option + Shift + Down arrow 
(Control + Alt + Shift + Down arrow)

Shift baseline -10 pts

Resets

Command + Shift + Y (Control 
+ Shift + Y)

Removes Bold, Italic, Superscript, Subscript, All 
Caps, Small Caps, Underline and Strikethrough

Command + Shift + X (Control 
+ Shift + X)

Resets vertical scale to 100%

Command + Option + Shift + X 
(Control + Alt + Shift + X)

Resets horizontal scale to 100%

Command + Option + Shift + A 
(Control + Alt + Shift + A)

Sets leading to (Auto)
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Chapter 6, Photography

Up to this point, we’ve discussed the  
creation of fairly passive elements: they’re  
necessary, but they don’t engage the user  
on the same level that a photograph  
does. Photography on the Web is  
extremely powerful, and that power has  
to be handled properly. A photograph — 
especially of the human face — 
immediately draws the user’s attention 

and can be used to direct eye flow to  
important areas of the page. Placing a  
large photograph above the fold is a  
common way to provide an entry point to  
the content. Because photographs are 
high above other elements in the  
hierarchy, they need to be handled with  
care and precision.
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Photography is subjective, and choosing images that complement your subject 
matter can be time-consuming. Some websites might call for explicit shots that 
quickly communicate an idea, present a product or simulate an experience. In other 
situations, the message might be best conveyed through metaphor or abstraction. 

The key to the perfect photo is balancing relevance and appeal: ensuring that the 
subject relates to the message that needs to be communicated and that the image 
appeals to the audience it is being directed at.

After devising your approach, you’ll have to conquer a number of technical hurdles 
gracefully in order to produce a high-end product. Prepping photos for on-screen 
display varies from prepping them for print. In addition to traditional concerns of 
color, tone, sharpness and composition, Web designers also need to be aware of 
interpolation and compression. In this chapter, we’ll cover the workflow for bringing 
photography to life on the Web.
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Garbage In, Garbage Out
Photoshop is a great tool and can do amazing and seemingly impossible things with 
photography. However, this black magic relies heavily on good source material; 
Photoshop simply adds the polish. You can easily make a good photo great, but 
making a bad photo anything better is impossible. Applying endless adjustments to 
a heavily over-exposed image will never give you the subtlety of a properly exposed 
image. Therefore, finding workable source material is vital to ensuring a quality 
product. Shots that a client’s nephew took with his mobile phone are a big red flag. If 
you’re using stock photography, spend the extra time sifting for just the right shot. If 
you’re the one shooting, make sure you’re not setting yourself up for a headache in 
post.

Resizing and Interpolation
Resizing is one of the most common types of edits. Ideally, you’d be working with 
beautiful, high-resolution photos that you only have to scale down. While not always 
possible, try to use images that are at least twice as big as the output size. This gives 
you a nice cushion and ensures that the final output is of the best quality quality. 
Avoid increasing the size of photos at all costs, even though it is sometimes 
unavoidable.

Whether you’re scaling up or down, understand how Photoshop determines pixel 
values. The calculation of pixel values when scaling is referred to as interpolation. 
This is done based on the color relationship of neighboring pixels. As a simple 
example, imagine one black pixel and one white pixel next to each other, scaled 
down to create one gray pixel. In its simplest form, this is how interpolation 
algorithms determine values.
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Photoshop provides five different methods of interpolation, each for a certain kind of 
resizing. Below is a breakdown of the modes and their purpose. You can change the 
interpolation method in two places. If you’re using the Free Transform tool, you 
would change it in the Preferences dialog. If you’re using the Image Size command, 
just change it in that same dialog.

Nearest Neighbor

The Nearest Neighbor mode is great for maintaining crisp edges and is most useful 
with rectangular shapes that line up with the pixel grid. When calculating a pixel’s 
value, this mode first determines an average color based on its neighbors and then 
makes it inherit the exact value of the neighbor closest to this average. Therefore, no 
new values are ever used.

 If you were to scale the image by 200%, you would notice that each pixel basically 
doubles in size (i.e. each pixel is now four pixels). This can be helpful when working 
with screenshots of interfaces for which you’d like to maintain crisp borders and 
avoid anti-aliasing.

Bilinear

Bilinear interpolation 
uses values from the 
four points closest to 
the sample point and 
blends them to find 
the average. This 
method outputs 
adequate results but 
is usually trumped by 
one of the Bicubic 
methods below.
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Bicubic

Best for smooth gradients. The Bicubic setting is Photoshop’s default and provides 
great results in most situations. By sampling more points per calculation, bicubic 
interpolation outputs much smoother results, making it ideal for photographs.

Bicubic Smoother

Best for enlargement. Bicubic Smoother uses an algorithm similar to that of the basic 
Bicubic but with more of a focus on blending, resulting in smoother results and less 
contrast along edges. When downsampling, this can make images look slightly 
blurry. Upscaling can be improved, though, by using Bicubic Smoother, which 
reduces common blocky artifacts.

Bicubic Sharper

Best for reduction. 
Unlike Bicubic 
Smoother, which 
reduces contrast 
along edges, Bicubic 
Sharper actually 
overshoots edge 
values. This results in 
an increase of 
“acutance,” which is 
the perceived 
sharpness of an 
image based on the 
contrast of its edges.
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Stair-Step Interpolation

Stair-step interpolation is a common technique when resizing images, particularly 
upscaling. By incrementally scaling and interpolating an image towards its final size, 
you can sometimes increase sharpness and preserve detail. Experiment with different 
increments, but 10% seems the most common for this method. Your results will vary 
based on the image and interpolation method used. It’s really a matter of trial and 
error.

Smart Objects
Photoshop CS2’s introduction of Smart Objects radically changed the way layers 
could be resized and interpolated. By converting a layer to a Smart Object, you 
ensure that however many times an image is resized, it will be interpolated only 
once. The Smart Object interpolation method is determined by the universal 
interpolation set in the Preferences dialog.

Smart Objects are critical to non-destructive editing. Any layer — even multiple 
layers — can be converted to a Smart Object by right-clicking the layer in the Layers 
palette and selecting “Convert to Smart Object.” This essentially extracts the data 
from the selected layers and puts it in a new document, which is embedded in the 
main document.

Because all of the data is now separate from the layer itself, Photoshop will pull the 
data from the original Smart Object every time a transformation is applied to it. Any 
time you need to edit the layers in the Smart Object, you can double-click its 
thumbnail, which will open a new PSB document containing all of the layers in the 
same state as when you created it. You can modify the Smart Object as if it were any 
other document; and when you’re finished, simply save it, and the document 
containing the Smart Object will be updated to reflect your changes.
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In addition to preserving the original data while resizing, Smart Objects also increase 
the flexibility of filters. Typically, filters are permanently applied to a layer, but filters 
on Smart Objects become a Smart Filter. As you add filters, they’re added to the 
layer in the Layers palette under the Smart Filters section. Each of the filters can be 
edited by double-clicking its name. You can even change the stacking order of the 
filters by dragging them up and down. Finally, you’ll notice a thumbnail next to the 
Smart Filters header: this is an additional mask that applies only to the filters. Like a 
standard layer mask, any areas that are painted black will be hidden.

In general, multi-layered Smart Objects make for an interesting, although somewhat 
unpredictable, feature: Smart Object Stack Modes. By selecting multiple layers and 
compiling them into a Smart Object, you can alter how those layers are composited 
by changing their Stack Mode (Layer → Smart Objects → Stack Mode). Each of these 
modes offer unique blending methods, but only a few of them are intuitive (the rest 
are based on complex algorithms, which render them impractical for a Web 
designer’s workflow).
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Color and Tone
Whether creative or corrective, color and tone adjustments are an important part of 
design. The color and tone of photographs must match the feel of the website. A 
photo’s color values are determined by the composition of its channels — because 
we’re Web designers and our final output is rendered in pixels, these are usually Red, 
Green and Blue. When making adjustments, you’re essentially altering the brightness 
value of each pixel’s red, green and blue component.

Adjusting the color or 
tone of an image is better 
done with a visualization 
of its values, known as a 
histogram. The 
Histogram palette 
(Window → Histogram) 
provides numerous 
visualizations that allow 
you to determine the 
image’s balance at a 
glance. What appears as 
jagged mountains is 
actually a representation 
of the sum of pixels with a corresponding value. When the Channel drop-down 
menu is set to RGB, each value along the x-axis (known as the levels) represents each 
pixel’s overall tonal value. Therefore, the values to the left of the graph represent 
pixels that are completely black or almost black, and values to the right move 
towards white. The same holds true when changing the Channel drop-down menu to 
Red, Green or Blue, except that the chart would then represent the values of that 
individual channel only.
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The histogram is critical to balancing the color and tone of an image and is seen in 
many of the adjustment dialogs. Typically, the values in a well-balanced image will 
range across the entire span of the histogram. Although the histogram is not directly 
editable, you can make two key histogram-based adjustments: Levels and Curves 
(see page 120 and 122 for details).

Adjustment Layers

Photoshop allows you to adjust layers directly via Image → Adjustments, but in the 
spirit of non-destructive editing, your best option is to use adjustment layers. At the 
bottom of the Layers palette is the “Create new fill or adjustment layer” button, 
which gives you access to the core adjustments. Choosing an option from the list will 
create a new layer named after the adjustment type. The adjustments to this new 
layer will be applied to all of the layers below it, but you can constrain them to a 
single layer by creating a clipping mask (Command + Option + G or Control + Alt
+ G).
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Preservation of data is not the only perk to using adjustment layers. They also 
provide superb flexibility by allowing you to modify the adjustment at any time via 
the Adjustments panel (Window → Adjustments). And because each adjustment is 
treated as a layer, you can prioritize them by changing the stacking order. What’s 
more, each of the adjustment layers can make use of blend modes, layer styles and 
masks, giving you total control over the implementation.

Brightness/Contrast

This self-explanatory adjustment comes in two sliders: one for Brightness and one 
for Contrast. The Brightness control allows you to increase or decrease brightness by 

150 units, and the 
contrast ranges from 
-100 to 100. It can be 
used to quickly add 
pop to a lifeless 
photo, but it lacks 
the control of more 
refined adjustments.

Levels

The Levels 
adjustment is 
extremely useful for 
its balance of 

simplicity and control. This histogram-based adjustment lets you set the range of 
values based on either composite or channel. By default, you’re presented with the 
RGB histogram, with three sliders along the bottom: black, gray and white. Each 
slider represents an absolute value. Black represents a 0 value, gray is 128 and white 
is 255. Moving these sliders adjusts the values relative to the new absolutes. 
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Therefore, moving the black slider to the right progressively darkens the image. All 
values to the left of the black slider will be mapped to 100% black, and the values to 
the right will adjust to the new black point. The gray slider sets the weight of the 
mid-point. By default, this is set to 1.00, which puts it evenly between the black and 
white points. As you move the black or white point, the gray point will auto-adjust to 
maintain the same percentage. Dragging the gray point to the right will darken the 
image, and dragging it to the left will lighten it.

The main slider points can also 
be controlled using the 
Eyedropper tools next to the 
histogram. By selecting one of 
the Eyedropper tools, you can 
click anywhere on the canvas to 
set that pixel’s value as the black, 
gray or white point. Holding 
Option (Alt) while mousing over 
the canvas will display the 
current values for that point. This 
provides a rather intuitive way to 
set values.

Below the black, gray and white 
point sliders are two other 
sliders that control the output 
levels. These control the 
maximum values for black and 
white, which are defaulted to 0 
and 255, respectively. Dragging 
the black output slider to 128 
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ensures that no values will be darker than 50%. You’ll notice that an Auto button is 
located above the histogram. Clicking it will loop through the channels and balance 
their black and white points, which in turn will also balance the composite image so 
that a full range of values is reached. As with any automatic setting in Photoshop, the 
result may be extreme and is no substitute for manual adjustments.

Curves

While the Levels adjustment is powerful, it falls short when you need to adjust more 
than the black and white points. This is where the Curves adjustment comes in 
handy. Of all the adjustment layers, it is arguably the most important. It allows for 
precise control of every value in the image.

The Curves adjustment looks similar to Levels: the histogram is front and center, 
there are black and white sliders, we can set which channel to work on, and the three 
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Eyedropper tools are there. The difference between Curves and Levels is in the 
gridded histogram. As in Levels, the left side still represents black and the right 
represents white, but Curves is a two-dimensional adjustment because it also plots 
data on the y-axis. The bottom of the histogram represents 100% black, and the top 
represents 100% white. The diagonal line running from the bottom-left to top-right 
corner represents how the values on the histogram (input) correspond to the 
adjusted values (output).

Initially, we have a perfectly diagonal “curve,” setting pure black to pure black and 
pure white to pure white. By clicking anywhere on the curve, you can add a new 
anchor point, which can be moved up, down, left or right. Moving the point up will 
lighten the corresponding values, and moving it down will darken them. Mindfully 
setting and adjusting anchor points can quickly resuscitate a lifeless photo. 

Exposure

By modifying the three sliders in the Exposure adjustment (Exposure, Offset and 
Gamma), you can correct exposures or simulate an over-exposure or under-
exposure. The Exposure slider is really the key to modifying and correcting the 
exposure, while the Offset and Gamma options allow you to change the lightness 
and color range.

Vibrance

The Vibrance adjustment provides two ways to adjust the saturation of colors. The 
Saturation slider adjusts it by simply increasing or decreasing the saturation of each 
individual pixel until the maximum or minimum value is reached. Vibrance, on the 
other hand, is a bit more sophisticated. By taking into consideration the original 
saturation value, the Vibrance slider intelligently increases or decreases saturation to 
reduce clipping (i.e. heavily saturated colors will gain less saturation than lower 
saturated ones). This is very useful when working with skin tones because it helps to 
maintain a more natural look.
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Hue/Saturation

At first glance, Hue/Saturation appears to be a simple adjustment that controls… 
well, the hue and saturation (and lightness, too). However, this adjustment is quite 
robust and versatile. It can be used to create black-and-whites, sepia effects and 
other duotones. It can even target particular ranges of colors to help balance them.
The three sliders adjust values for each pixel in the current color group relative to the 
pixel’s original value in the HSB color model. By checking Colorize, you can set all 
values to grayscale, at which point the Hue, Saturation and Lightness sliders will add 
color. This is great for quickly creating sepia tones and other duotones.

By default, all values are 
modified in the Master 
group. This applies the 
adjustment to the entire 
image. You can rotate 
through different color 
groups using the drop-
down menu above the 
sliders. You’ll notice that 
color stops are added 
to the spectrums at the 
bottom. This allows you 
to target a particular 
range of colors. By 
using the hand-pointer option in the upper-left of the dialog, you can automatically 
set the color range by clicking anywhere on the image. You can even click-drag on 
the image to change the saturation or Command (or Control) + click and drag to 
change the hue.
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The relationship between the adjusted values and the originals can be seen in the 
spectrums at the bottom of the dialog. The top spectrum represents original values, 
and the adjusted values are on the bottom. The bar between the two is where the 
range stoppers appear when working with a single color group. Measured in 
degrees, the four range stoppers represent the beginning and end of the range as 
well as the edge gradation.

The triangular stops represent the color at which the adjustment should end; any 
value beyond them will receive no adjustment. The rectangular stops represent the 
internal range within which 100% of the adjustment will be applied; areas between 
the internal and external ranges will receive only a percentage of the adjustment. 

This helps to maintain a natural and smooth transition from one color to the next, 
but they can be adjusted as you see fit. Modifying the stoppers is as simple as 
dragging them left or right, but you can also use the Eyedropper tools to add, 
remove or change the values.

If you happen to move a color group’s range from its original color to another, 
Photoshop will rename the color group accordingly. For example, if the group is set 
to Cyan, and you move it to a range of red colors, then the group will be renamed 
Red 2.

Color Balance

Color Balance does exactly what its name suggests: it balances colors between Red, 
Green and Blue and their counterparts Cyan, Magenta and Yellow. Range control is 
provided by way of the three radio buttons: Shadows, Midtones and Highlights. The 
Preserve Luminosity check box allows you to maintain consistency between light and 
dark areas. This adjustment is helpful for quick color shifting, but it doesn’t match 
the control of Curves, which can achieve the same result.
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Black and White

A number of adjustments can remove color from an image — Hue/Saturation, 
Vibrance, Gradient Map — but none compare to Black and White. By having control 
over how much of each color is used for the composited Black and White image, you 
can pull much more contrast and detail. You can also create duotones using the Tint 
feature.

Photo Filter

Photo Filter simulates what the image might look like if it were taken with a 
particular filter on the camera. This can be used to subtly or drastically tint images 
warmer, cooler or towards a certain hue.

Channel Mixer

The Channel Mixer controls the values in each channel by adding and subtracting 
values from other channels. This can help with subtle color adjustments but is rather 
unintuitive. Turning on the Monochrome check box gives you a slimmer version of 
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the Black and White adjustment, controlled by the three channels as opposed to the 
six color groups.

Repair
Whether you’re abolishing creases from a turn-of-the-century photograph, removing 
unwanted objects from a stock image or smoothing out blemishes from a portrait, 
photo repair is a necessary skill. There is an art to removing objects and covering up 
imperfections. It must be done with a careful eye so that it avoids ending up in a 
Photoshop Disasters post (http://bit.ly/1VwDZr). Removing a blemish is easy, but 
maintaining the realism can be difficult. Luckily, Photoshop provides a number of 
tools to help with the process, most of which are brush-based (see Brushes on page 
54). These tools work by sampling data from similar areas of the image and blending 
them with the target area.

Clone Stamp

The Clone Stamp is the original repair tool. It allows you to set a source from where 
pixels will be copied and applied to the target area. You can set the source area by 
Option-clicking (Alt-clicking) anywhere on the canvas. Upon setting the source, you 
can paint directly to the area you want to repair. If you’re using a newer version of 
Photoshop, an overlay of the source area will follow your cursor to help with 
alignment. Because the stamp tool is brush-based, you can modify the Radius, 
Hardness, Opacity, Fill and other settings to make your clone blend properly with its 
surrounding. Reducing the Fill and Hardness and sampling multiple times with slight 
variations is a good technique for maintaining realism, especially with soft areas such 
as skin tones.

Always copy the layer you’re working on before applying destructive edits to it. 
Better yet, avoid destructive edits altogether. Thankfully, the Clone Stamp provides
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a way to avoid applying cloned areas to the original layer via the Sample drop-down 
menu in the properties bar. 

Start by creating a new layer above the layer(s) you’d like to repair and select the 
new layer. Then, set the Sample option to All Layers (or Current and Below if other 
layers are interfering). Now, any cloning that occurs will be sampled to the new layer 
and not the original. This allows for much greater flexibility and ensures that the 
original data stays intact. If adjustment layers are shifting your sample, you can click 
the “Ignore adjustment layers while cloning” option to exclude them from the 
source.

The Aligned option 
— located in the 
Clone Stamp tool’s 
property bar — 
determines whether 
each clone will start 
at the source. When 
checked, the first 
clone will sample 
from the source’s 
coordinates, and any 
subsequent clones 
will be sampled 
relative to the first 
clone.

For example, let’s assume the source is located at x:100, y:100, and the first clone is 
at x:200, y:200. If the second clone is at x:225, y:225, then its sample will be located at 
x:125, y:125. When the Aligned option is unchecked, the second clone would change 
to the original source coordinates of x:100, y:100. More advanced options for the 
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Clone Stamp tool can be found in the Clone Source palette (Window → Clone 
Source). At the top of this palette are five clone source icons, each representing a 
unique sample area. Clicking an icon activates it, and any source area set while it’s 
active will be mapped to it. You can then come back to that source at any time by re-
clicking it.

The distance between the source and the first clone is known as the “Offset.” You’ll 
notice that after you’ve set a source area and move the cursor around, the X and Y 
values are updated to reflect the difference. These values can be edited after cloning, 
but it’s rather difficult to predict the results. To alter the offset in a more intuitive way, 
Option + Shift + Drag (Alt + Shift + Drag) to the desired location. Next to the Offset 
are options for scaling and rotating the clone. The three inputs are fairly intuitive: 
setting the width and height to 50%, for example, will clone at half size. Beside the W 
and H options are circular arrows that allow you to flip the clone horizontally or 
vertically.

If you’re cloning across the frames of an animation or video, you can use the Frame 
Offset, which lets you set the frame of the source. The offset can be set to a positive 
or negative integer to target future or past frames, respectively. The Lock Frame 
option ensures that every clone samples from the frame where the source was 
originally set.

The bottom section of the Clone Source palette contains options for controlling the 
appearance of the overlay. You can toggle the overlay on and off, change its opacity 
and modify its blending mode. The Clipped option dictates whether the source is 
shown only in the brush shape or the entire layer is shown. Auto Hide removes the 
source overlay as you paint, and Invert inverts the overlay only (the clone itself is not 
inverted).
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Healing along sharp  
edges can sometimes  

absorb color from 
nearby elements (as  

seen on the left).  
Setting a selection  

around the area can  
help remedy this.

Healing Brush

Similar to the Clone Stamp but far more advanced, the Healing Brush clones data 
from the source and analyzes the data so that it can intelligently blend it with the 
existing layer data. The result of this process is typically much more natural. The 
drawback of the Healing Brush is that it sometimes loses subtle textures in the 
blending process. This can be advantageous when repairing areas such as a cheek, 
but it can also lead to awkwardly smooth blotches along a surface. In such cases, 
using the Clone Stamp tool or a combination of the two is best.

When using the Healing Brush along contrasting edges, you’ll sometimes pick up 
unwanted color from outside of the brush shape. This is because Photoshop is using 
an area larger than the brush to help determine the result. This can be problematic, 
but there’s a quick remedy. By making a tight selection over the area that needs to 
be healed, you can limit the pixels that are included in the blending process.
The Pattern Sample option allows you to specify a pattern to blend with the target 
area. This option might prove useful for creative flourishes but is less effective for 
general repair.
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Spot Healing Brush Tool

The Spot Healing Brush is an offshoot of the Healing Brush. It provides a similar 
blending process but doesn’t require — or even allow — a source. When the tool’s 
Type option is set to Content-Aware, the tool analyzes the pixels in the image to 
determine how the area should be filled. This works remarkably well in many 
circumstances, but by sacrificing the ability to manually set the source, you lose a lot 
of control. Therefore, this tool is best reserved for healing small and simple areas.

The Type option for the Spot Healing Brush is almost always best left on Content-
Aware, but the other two options may be helpful as well, and if you haven’t 
upgraded to CS5, they’re all you have access to. The Proximity option samples pixels 
around the painted area. This is similar to the Content-Aware option, but it may not 
preserve texture and shading quite as well. The Texture option takes areas within the 
image, bumps up the contrast and blends them over the painted area. This can be 
helpful for small areas, but it looks atrocious in large areas. In fact, if the area is too 
large, you’ll actually remove texture, leaving you with a large blurry area.
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Changing the Blend Mode is another way to gain more control of this tool. The 
Normal setting usually does the trick, but depending on your image, the Replace 
setting might do a better job of preserving texture. The other modes should be 
familiar to you; you can use them to ensure that the sample targets the color or 
luminosity of the area.

Patch Tool

Like the Clone Stamp and Healing Brush, the Patch Tool allows you to set a sample 
area, but it uses an entire selection as its source. Begin by setting a selection, either 
with the Patch tool (which acts as a standard Lasso tool) or by using a prior selection. 
After the selection is made, drag it — depending on the Patch setting, you’ll either 
sample to (Destination mode) or sample from (Source mode) the target area. The 
sample will then be blended as is done with the Healing Brush. If you’re using the 
Patch tool to set your selection, you can use Shift to add to the current selection, 
Option (Alt) to subtract from it and Shift + Option (Shift + Alt) to intersect with it. 

Content-Aware Fill

One of the most anticipated features of Photoshop CS5 was the Content-Aware Fill, 
which promised to alleviate nightmarish repair work by intelligently filling in the 

blanks. While the 
tool is somewhat hit 
or miss, when it hits, 
it really hits. Begin 
by selecting the area 
that needs to be 
filled. Then, initialize 
the Fill dialog (Shift 
+ F5), and you’ll 
notice that Use now 
has a Content-Aware 
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 The images on the  
right have been 
programatically  

sharpened. They have  
much higher acutance  
(or edge contrast) than  
the images on the left.

option. Click OK, and watch as Photoshop works its magic. Depending on the image 
and your selection, you’ll either achieve a seamless repair that needs no further 
retouching or a laughable mess. While this option doesn’t rival manual healing by a 
skilled hand, it does make a designer’s job much easier by speeding up the process. 
If you’re lucky and the fill has seamlessly created an area of your image, then bravo! 
Chances are, though, that this feature is more of a jumping off point: use it to start 
the process, but follow up with the Clone Stamp or Healing Brush to rework trouble 
spots.

Sharpening
After all of the resizing, transforming and adjustments, a photograph often needs to 
be sharpened. Sharpening can really bring a photo to life, but it must be done very 
carefully so as not to create any artifacts or halos. Notice that adjusting the 
sharpness of an image
after it has been shot is
much different than
tweaking the focus of
a camera lens.
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Unsharp Mask gives  
you great control over  
the amount of  
sharpening 
and the range to which  
it is applied.

Post-production sharpening relies on changing the perceived sharpness by 
increasing the contrast along edges, referred to as “acutance.” Photoshop provides 
five filters for sharpening, all located in the Filters menu (Filters → Sharpen). 

Sharpen, Sharpen More and Sharpen Edges

Sharpen, Sharpen More and Sharpen Edges are quick and dirty ways to increase the 
sharpness of an image. They all apply a standardized amount of sharpening that 
cannot be adjusted and are rarely ideal. Give them a try and maybe you’ll luck out, 
but you’re much better off using Unsharp Mask or Smart Sharpen.

Unsharp Mask

Unsharp Mask had a long run as the way to sharpen. Unlike the generic sharpening 
filters, Unsharp Mask allows you to adjust the amount of sharpening. 
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You can also modify the filter’s Radius and Threshold. The Radius setting controls the 
sampling area. Larger radii result in more dramatic sharpening but usually create 
unwanted halos. You’re best off leaving the radius as small as possible to achieve the 
desired effect. The Threshold limits the range to which the sharpening is applied. A 
setting of 0 applies to the entire image, whereas a setting of 20 limits the sharpening 
to neighboring pixels whose values differ by at least 20. The Amount, Radius and 
Threshold afford you great control over which pixels are sharpened and by how 
much, but the introduction of Smart Sharpen has changed the way we think about 
sharpening.

Smart Sharpen

Much like Unsharp Mask, the Smart Sharpen filter allows you to control the amount 
of sharpening along with the radius, but that’s where the similarities end. Smart 
Sharpen opens a slew of features to make sharpening more intuitive and 
customizable. The other core option available is the Remove setting, which 
determines the sharpening algorithm. 

By default, this is set to Gaussian Blur, which is the same algorithm that Unsharp 
Mask uses. The Lens Blur setting attempts to sharpen finer details, and the Motion 
Blur setting can help remove the blur from moving subjects (for best results, the 
Angle setting must be tweaked with the Motion Blur setting to run parallel to the 
blur streaks in the image). The More Accurate check box can be turned on to process 
the image more intensively; this slows the process down but can deliver sharper 
results.

Toggling the Basic option to Advanced will reveal three tabs: Sharpen, Shadow and 
Highlight. The Sharpen tab holds all of the options from the Basic mode. The other 
two are new, and as their names imply, they control how the sharpening is applied to 
the dark and light areas. These options are like the Threshold option in Unsharp 
Mask, but with more customization. By modifying these options, you can really 
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reduce the appearance of halos and without loss of acutance. The Fade Amount 
reduces the amount of sharpening applied to the pixels considered to be Shadows 
or Highlights. Tonal Width adjusts the range of values that make up the Shadow or 
Highlight. Values towards the left will decrease the range and thus target only the 
darkest or brightest edges. Finally, the Radius controls how many surrounding pixels 
are evaluated when determining whether a pixel is a Shadow or Highlight: the higher 
the value, the smaller the range of sharpened pixels. Note that modifying the Tonal 
Width or Radius has no effect on the sharpening process unless the Fade Amount is 
set higher than 0%.

High Pass

Though not listed in the Sharpen filters, another filter is commonly used to increase 
the acutance of edges. The High Pass filter (Filter → Other → High Pass) outputs a 
grayish version of the current layer with intensified edge contrast. Areas with subtle 
value changes will be about 50% gray, and areas with sharp contrasting edges will be 
closer to either black or white. 
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At first, this grayish layer might seem somewhat useless, but applying the High Pass 
filter to a copy of the original layer and changing its blending mode to Overlay, Soft 
Light or Hard Light will sharpen the image with dramatic effect. You can experiment 
with the three blend modes and the layer’s opacity along with the Radius setting of 
the High Pass filter to achieve results similar to those of Unsharp Mask.

Masking
Photoshop masks are the cornerstone of the non-destructive editing process. 
Photoshop offers five methods of masking: Pixel Masks, Vector Masks, Quick Masks, 
Clipping Masks and Clipping Paths, all of which define pixel opacities without 
affecting the original data. Each has its pros and cons, and knowing which method to 
use is important to creating clean, flexible and properly masked layers.
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Pixel Masks

Pixel masks determine opacity values based on a raster image with grayscale values 
that correspond pixel for pixel to the original layer. This makes them ideal for 
masking complex photographic imagery (e.g. the hair on a model or leaves on a 
tree). Pixel masks allow for 100 shades of gray, which correspond directly to opacity 
percentages. The ability to vary opacities is unique to pixel masks, making them an 
invaluable tool.

While pixel masks can be easily modified, they aren’t ideal for every situation. 
Because of their raster format, scaling them can cause unwanted artifacts and 
interpolated blurriness. Smooth curves and perfect edges can also be tricky to create 
when painting a mask. In such circumstances, vector masks would be preferable.

Creation

Creating a pixel mask is as easy as selecting the layer or layer group and clicking the 
“Add Layer Mask” button at the bottom of the Layers palette. A second thumbnail 
will be added to the layer, giving you a preview of the mask. By default, this will be 
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entirely white. However, if a selection happens to be active when you’re creating the 
mask, then it will be used to define the grayscale values of the mask. Once a mask is 
created, it can be edited as if it were any other pixel data by clicking on the mask’s 
thumbnail. You can then paint in black to hide areas or paint in white to reveal them. 
The mask can also be tweaked using adjustments and filters such as Curves, 
Threshold, Unsharp Mask and Gaussian Blur.

 
View Modes

When creating a mask, there are a number of ways to view the mask data. Option-
clicking (Alt-clicking) on the thumbnail will display only the mask on the canvas. This 
is great for fine-tuning areas, but it doesn’t show you the actual layer as you’re 
working. To see both the mask and layer at the same time, view the mask as a Ruby 
overlay. Simply press \ with the layer selected to toggle the overlay on and off. The 
color and opacity of the overlay can also be changed by double-clicking the mask’s 
thumbnail. Additionally, you can toggle the mask on and off by Shift-clicking on the 
mask’s thumbnail.
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Channels

Every time a layer with a mask is selected, the mask is shown as a temporary alpha 
channel in the Channels palette. From here, you can save the channel for later use
by dragging the 
channel to the 
“Create new 
channel” button 
at the bottom 
of the palette or 
just by selecting 
“New Channel” 
from the flyout 
menu. You can 
also change the 
mask’s Ruby 
overlay settings 
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by double-clicking the channel’s thumbnail. Because a temporary channel becomes 
available whenever a masked layer is selected, you can use keyboard shortcuts to 
toggle between the actual layer and its mask. Pressing Command + \ (or Control + \) 
selects the mask, and Command + 2 (or Control + 2) brings you back to the layer 
data.

Vector Masks

Vector masks pick up where pixel masks fall short. By defining the mask’s shape 
using paths, vector masks provide a superior level of finesse and flexibility. They’re 
ideal for defining shapes with clean, crisp lines. The disadvantage of vector masks is 
that they cannot vary pixel opacities; they are basically either 0 or 100. For this 
reason, many masking jobs require a hybrid implementation. By using a vector mask 
to define the solid edges and a pixel mask for more complex areas or for varying 
opacities, you can effectively extract objects while maximizing flexibility.

 

Smashing eBook Series: #3 | Mastering Photoshop for Web Design | 141

Chapter 6, Photography

Vector  
Masks are  

ideal for  
masking  

crisp-edged  
objects.



Creation

To add a vector mask to an existing layer, simply Command-click (Control-click) the 
“Add Layer Mask” button at the bottom of the Layers palette. If a path is currently 
active, the mask will be created using it. Otherwise, the mask will be empty. Paths can 
then be added, subtracted or modified by clicking the mask’s thumbnail.

View Modes

By clicking on the Vector Mask’s thumbnail in the Layers palette, you can show or 
hide the paths saved in the mask. These paths can also be accessed from the Paths 
palette, but only if the layer itself is selected. Toggling the mask on and off can be 
done by Shift-clicking the thumbnail.

Paths

Much like how layer masks appear in the Channels palette, a temporary work path is 
displayed in the Paths palette when a layer with a vector mask is selected. You can 
then save the mask by dragging it to the “Create new path” button at the bottom of 
the palette or by selecting “Save Path” from the flyout menu. This temporary path 
can be accessed at any time by first selecting the Path Selection tool (A) and then 
pressing Enter; it can be dismissed by pressing Enter again. You can also quickly 
create a selection from an active path by pressing Command + Enter (Control + 
Enter).

Applying

Before applying a vector mask to a layer, you must first rasterize it by right-clicking 
the vector mask thumbnail and choosing “Rasterize Vector Mask.” If the layer already 
has a pixel mask, then the two masks will be composited together to create a single 
pixel mask. It can then be applied like any other layer mask (i.e. right-clicking the 
thumbnail and choosing “Apply Layer Mask”).
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Quick Masks

The Quick Mask mode allows you to create a selection using pixel-editing tools as 
opposed to the primitive selection tools. This is a more logical approach to creating 
a complex mask with variable opacity. You can access this mode by clicking on the 
“Quick Mask” button in the Tools bar or by pressing “Q.”

Once in Quick Mask mode, you’ll no longer be editing the current layer. Instead, 
you’ll be editing a Ruby overlay that can be edited as if it were regular pixel data. By 
default, entering this mode will cover the entire canvas with a semi-transparent red 
color. You can then paint white to remove the overlay and paint black to add it back. 
The Quick Mask is essentially a more visual representation of a selection. Therefore, 
every area that you remove from the overlay is added to the selection.

Options

You can modify how the Quick Mask mode is displayed by double-clicking the 
“Quick Mask” button in the Tools bar. Here you can change the color and opacity of 

Smashing eBook Series: #3 | Mastering Photoshop for Web Design | 143

Chapter 6, Photography

Quick Mask  
mode allows  
you to quickly  
paint a  
selection.



the mask as well as whether the 
mask color indicates masked 
areas or selected areas. Personally, 
I find painting selected areas 
more intuitive than painting 
masked areas, which is the 
default.

Saving

After creating a quick mask, you 
can either immediately apply it to 
a layer by creating a layer mask or save it for later use. By selecting Selection → Save 
Selection, you can save your selection as a new channel or apply it to an existing 
channel. This allows you to come back to the selection at any time by Control-
clicking the channel in the Channels palette or by selecting Selection → Load 
Selection.
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Clipping Masks

You’ll often run into situations in which multiple layers require the same mask. You 
could group the layers and mask the layer group, but that is not always ideal. 
Clipping masks allows for a layer to adopt the opacity of an underlying layer. 

The easiest way to create a clipping mask is to Option-click (Alt-click) between the 
two layers in the Layers palette when the clipping mask cursor appears. Alternatively, 
you could press Command + Option + G (Control + Alt + G) to clip a layer to the 
one below it. Any number of layers can be clipped to the master layer, but a clipped 
layer cannot be used as a clipping mask itself.

Clipping Paths

Clipping Paths are a lot like Vector Masks except that they apply to an entire 
document rather than a layer or layer group. They are used primarily by print 
designers to specify uniquely shaped objects that are imported into a page layout 
program. The path is imported along with the image to ensure a crisp clean edge.

Smashing eBook Series: #3 | Mastering Photoshop for Web Design | 145

Chapter 6, Photography

Clipping  
Masks are  
great for  
constraining  
Adjustment  
Layers.



To create a clipping path, first be sure that you have a path saved; a temporary Work 
Path does not suffice. You must select “Save Path” from the flyout menu in the Paths 
palette if your path is not saved. Then, from the flyout menu, choose “Clipping Path.” 
Your document’s appearance will not change, 
but if you were to import the document into 
Illustrator using the Place command, it would 
be clipped to the path.

Masks Palette

The Masks palette was introduced in CS4 and 
has changed the way we create and refine 
masks. For the first time, we could feather 
and fade masks without losing the original 
data. In CS5, we have exactly the same basic 
controls, but a few updates have been made 
to the Mask Edge dialog.

Create/View Buttons

At the top of the palette are two buttons that 
can be used to select the layer mask or vector 
mask, or to create one if one doesn’t exist. If 
the layer contains Smart Filters, then you’ll 
also get a Filter mask icon.

Density

The density slider basically controls how 
strong the mask is. At 100%, fully masked 
areas will be completely transparent. 
When density is set to 50%, those same
areas will be only 50% transparent.
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Feather

Feathering the edges of a mask used to require applying a Gaussian Blur, which 
would destroy the original mask shape. With the Masks palette, you can now change 
the amount of feathering at any time while maintaining the original mask data.

Mask Edge

The Mask Edge menu delivers some long-desired features that aid in refining a 
mask’s perimeter. They come in very handy when the extracted object is still picking 
up color from the masked background.

View Mode

The View drop-down menu allows you to control how the mask is previewed. This 
setting is completely based on preference, but some modes work better for certain 
implementations. Note the various keyboard shortcuts contained in this menu. The 
shortcut to temporarily hide the mask view (“X”) is particularly useful for seeing the 
result. Show Radius is helpful for tweaking the Edge Detection Radius, especially 
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when using the Refine Radius Tool. The Show Original option toggles the 
appearance of the mask before any of the Refine Mask adjustments are made. 

Edge Detection

The Radius setting is similar to feathering, but it retains some of the edge’s crispness. 
This can be helpful for reducing awkward or overly sharp edges of complex shapes. 
By checking Smart Radius, Photoshop determines the sharpness of the edges and 
adjusts the Radius accordingly.  To the left of the Edge Detection legend is an icon 
for the Refine Radius Tool. This brush-based tool allows you to manually add or 
remove areas from the radius. By default, the tool is set to add, but you can activate 
the Erase Refinements tool by pressing Shift + E or by clicking and holding the icon 
or simply by holding Option (Alt) while painting.

Adjust Edge

Smooth
Smooth simplifies the complexity of the mask’s edges. This can be useful if you’ve 
painted the mask by hand and need to quickly clean up some rough edges.

Feather
This feather command is nearly identical to the Mask palette’s primary feather 
command, but it restricts the blur more to the edge of the mask. The difference is 
slight yet noticeable.

Contrast
Contrast simply modifies the contrast of edge elements, which helps to crispen soft 
edges. Using this in conjunction with Radius can help remove unwanted artifacts in 
the mask. 

Shift Edge
Formerly the Contract and Expand slider, this option allows you to grow and shrink 
the edges of the mask. This is extremely useful for reducing unwanted color fringes.
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Output 
The Output section allows you to set how the Refine Mask adjustments are applied. 
You can set the changes directly to the Layer Mask, or you can create a new layer or 
even a new document with the mask automatically applied or preserved in a layer 
mask. The Decontaminate Colors option processes the edges of the mask and 
removes any unwanted color fringes.

Color Range
The Color Range menu is one of the most powerful ways to extract an image from 
an evenly colored background. With only a few clicks and adjustments, even the 
most complex object can be cleanly masked.

Quick Tips
Post-Apocalypse

Recreating the typical deserted city street effect seen in post-apocalyptic films is 
made easy by using a video clip and Smart Objects. This technique relies heavily on a 
video clip in which the camera remains stationary with no zoom or pan; but you can 
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also use multiple stills taken consecutively. We will sample a median of every frame 
and piece it together, basically eliminating anything that has moved during the clip. 
This technique will also eliminate the noise in each frame, leaving us with a smoother 
and more detailed image.

Start by importing your video by selecting File → Import → Video Frames to Layers. 
Once the layers are imported, select them all, and convert them to a Smart Object by 
right-clicking one of the layers and choosing “Convert to Smart Object.” Next, 
choose Layer → Smart Objects → Stack Mode → Median. 

Color Range Masks

When an object needs to be extracted from an evenly colored background (much 
like the video-editing process of Chroma keying), the quickest means is often the 
Color Range command.
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First, use the Eyedropper tool to select the primary background color. Then, use the 
“Add to sample” and “Remove from sample” tools to refine the color selection. The 
fuzziness slider lets you broaden the range of colors selected. If the color data is 
there to support it, this process makes short work of an otherwise tedious task.
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Masks From Channels

A mask often hides in one of the layer’s channels, just waiting to be unlocked. 
Depending on your image, you may be able to find a channel with a strong contrast 
between the target object and its surroundings. You might even want to temporarily 
change the color mode to Lab or CMYK to access alternative channel options. Once 
you’ve found a channel with strong enough contrast, Command-click it to create a 
selection. Then, apply the selection as a layer mask. You’ll then be able to tweak it as 
you would any other mask. 

As the image below demonstrates, simply selecting a channel is not always sufficient 
for a clean mask. You may need to do some mixing with other channels.

Smashing eBook Series: #3 | Mastering Photoshop for Web Design | 152

Chapter 6, Photography



1. The original image has strong vibrant colors, making it a great opportunity to 
create a mask using channels.

2. The red channel has the right foreground-to-background contrast, so we’ll 
start there. We’ve copied and pasted it onto a new layer and then inverted it.

3. The green cup is still prominent, so we’ve converted the blue channel to a 
layer and will use it to negate the green and red cups.

4. By setting the Blending Mode on the blue channel’s layer to Multiply, we can 
effectively erase any extraneous white areas.

5. The two layers are then flattened and applied as a layer mask to the original 
image. This leaves us with a cleanly masked blue mug.

Pixel/Vector Hybrid Masks

Objects will quite often have a combination of sharp edges and soft feathered edges. 
In such instances, using both a pixel and a vector mask may be best. One common 
example of this is extracting a figure. You can use the Pen tool to draw all of the 
smooth edges along the figure’s body, and then use a pixel mask to paint in the fine 
details such as hair.

Multiple Masks

At times you may want to apply more than one mask to a layer. You could apply the 
mask by right-clicking the layer and selecting “Apply Layer Mask,” after which you 
could apply a new mask. This, however, is not ideal because the data behind the 
mask will be lost.

A far better method is to create a Smart Object from the layer and mask the new 
layer. This allows you to apply two masks to one layer without losing data. In fact, if 
needed, you could repeat this process over and over.
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Removing Edge Fringes

Even after using the “Refine Edge” command in the Masks palette, you may find 
random color fringes left along the edge of your mask. This is where some manual 
brushwork comes in handy. The Paintbrush tool can be used here, but I recommend 
the Healing Brush, Stamp tool or Smudge tool because they will blend better with 
the subject.

First, create a new layer and clip it to the masked layer. Then, set your tool of choice 
to sample all layers. You can now select the sample area and paint the fringes out; 
the original layer data will be preserved. Changing the brush’s Blend Mode will often 
preserve the detail of the layer.
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Keyboard Shortcuts

Tools

S (Shift + S to cycle through) Clone Stamp and Pattern Stamp

J (Shift + J to cycle through) Spot Healing Brush, Healing Brush, Patch 
tool and Red Eye tool

O (Shift + O to cycle through) Dodge, Burn and Sponge tools

Adjustments

Command + L (Control + L) Levels

Command + M (Control + M) Curves

Command + U (Control + U) Hue/Saturation

Command + B (Control + B) Color balance

Command + Option + Shift + B (Control + Alt + Shift Black and white
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Fringes can 
usually be  
smudged or  
painted 
away on a  
clipped  
layer.



+ B)

Command + Shift + U (Control + Shift + U) Desaturate

Command + I (Control + I) Invert

Command + Shift + L (Control + Shift + L) Auto-tone

Command + Option + Shift + L (Control + Alt + Shift + 
L)

Auto-contrast

Command + Shift + B (Control + Shift + B) Auto-color

Masks

“\” View Layer Mask as an overlay

Command + \ (Control + \) Set layer focus to Layer Mask

Command + 2 (Control + 2) Set layer focus to layer data

Command + Option + \ (Control + Alt 
+ \)

Create selection from Layer Mask

Command + Option + G (Control + 
Alt + G)

Make or release Clipping Mask

A, then Enter Activate or dismiss Vector Mask

Command + Enter (Control + Enter) Create selection from active vector mask

Command + Click Mask Thumbnail 
(Control + Click Mask Thumbnail)

Create selection from mask

Command + Option + Click Mask 
Thumbnail (Control + Alt + Click 
Mask Thumbnail)

Subtract mask from selection
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Command + Option + Shift + Click 
Mask Thumbnail (Control + Alt + 
Shift + Click Mask Thumbnail)

Intersect mask from selection

Q Toggle Quick Mask mode

In the Color Range Dialog

Option (Alt) Toggle the Reset button and the “Subtract from 
Sample” tool

Command (Control) Toggle between the Selection view and Image view

Shift Toggle the “Add to Sample” tool

In the Levels and Curves Dialog

Option + 2, 3, 4 or 5 (Alt + 2, 3, 4 or 
5)

Cycle through RGB, Red, Green and Blue channels

In the Refine Mask Dialog

J Show radius

P Show original

M Marching ants

V Overlay

B On black

W On white

K Black and white

Smashing eBook Series: #3 | Mastering Photoshop for Web Design | 157

Chapter 6, Photography



L On layers

R Reveal layer

F Cycle through view modes

E (Shift + E to cycle 
through)

Refine Radius tool and Erase Refinements tool 

Z Zoom tool

H Hand tool

Clone Stamp and Healing Brush

Option + Click (Alt + Click) Set Sample location

Option + Double-click (Alt + Double-click) Select Aligned option (Clone 
Stamp only)

For more shortcuts, see Brushes: Keyboard Shortcuts on page 74.

Filters

Command + F (Control + F) Last filter

Command + Option + F (Control + Alt + F) Last filter with dialog

Command + Shift + F (Control + Shift + F) Fade filter just applied

Smashing eBook Series: #3 | Mastering Photoshop for Web Design | 158

Chapter 6, Photography



Chapter 7, Exporting

Once you’ve polished every last pixel, it’s  
time to get your work into the browser.  
This is a pretty straightforward process,  
but properly optimizing your images is  
crucial. You need to maintain a balance  
between clarity and download speed.  

This requires multiple formats, varying  
levels of compression and other  
optimization techniques. In this chapter,  
we’ll explore the workflow of exporting  
images via the “Save for Web and 
Devices” dialog.
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Save for Web and Devices
Every image that is exported and that will ultimately end up in a browser should be 
sent through the Save for Web and Devices dialog. This dialog provides everything 
you need to optimize and save your images for the Web. Not only does it save 
images in a particular format, it gives you control over quality, transparency and 
colors. Tweaking all of these settings is key to reducing a file’s size while keeping the 
quality as high as possible. This is increasingly important today, as more and more 
people access the Web via mobile devices, where smaller file sizes are more crucial 
to a smooth experience. 

We’ll begin by examining the interface of the Save for Web and Devices dialog, 
which can be accessed via the File menu or by pressing Command + Option + Shift 
+ S (Control + Alt + Shift + S). The first thing you’ll likely notice is the large image 
window. By default, you should see one large image, which may look slightly 
different from your actual file. This is because you’re currently viewing the optimized 
version. There are four different view options, which can be changed by the tabs in 
the upper-left corner: Original, Optimized, 2-Up and 4-Up. The Original view shows 
the file exactly as it appears outside of the dialog. The Optimized shows the file after 
the current compression settings have been applied. 2-Up and 4-Up split the screen 
into panels to allow you to compare the differences between the original and 
optimized versions. The 4-Up view even allows you to test multiple settings. By 
clicking into one of the panels, you activate its settings, which can be changed 
without altering any of the other panels. This can be valuable for testing different 
compressions. 

At the bottom of each view panel is a brief summary of the associated file type, 
along with the file size and an estimated download time. Remember, the goal here is 
to get that file size down as low as possible without disrupting the quality. You’ll 
want to keep a close eye on this summary. If you like, you can change the simulated
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download settings to get a better approximation of the file’s speed by clicking the 
“Select Download Speed” button. 

To the right of the view panels are the file settings. This is where all of your 
compression work will be done. These options vary greatly depending on the file 
format you’re exporting to. This dialog gives you access to five different file formats: 
GIF, JPEG, PNG-8, PNG-24 and WBMP. 

Format Specific Options
GIF

The Graphics Interchange Format (GIF) is great for saving logos, text and other 
graphic images. This format uses a lossless compression, meaning that the highest 
quality is maintained in the process. However, the GIF format allows only 256 colors. 
That is not to say that you can only choose between a set number of 256 colors, but 
rather that the file is able to store up to 256 colors, from which each pixel will be 
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colored. This makes it less than ideal for photographs, but perfect for images with 
large blocks of solid color.

 
Color Reduction 
If you set the Optimized file format drop-down menu to GIF, you’ll see a number of 
options to control how the GIF will be compressed. The very first option is the 
palette reduction algorithm. Because the GIF format can store only 256 colors in its 
color table, Photoshop will run the image through an algorithm to determine which 
pixels to keep and which to discard.

Some of the methods are self-explanatory, such as Black, White and Grayscale. Some 
are basically useless, such as Mac OS and Windows, which attempt to simulate the 
typical gamut of those platforms. And then there’s Custom, which lets you set the 
entire color palette yourself. This can be rather tedious, and you’re better off with 
one of the remaining four methods: Perceptual, Selective, Adaptive or Restrictive.
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The Perceptual algorithm prioritizes colors that the human eye is most adapt at 
perceiving, but it is less accurate at reproducing exact color values. Selective 
determines which colors are used the most and in the largest concentration, and it 
ensures that those are maintained. This makes Selective a great choice for most 
images. The Adaptive setting is similar to Selective, except that it prioritizes colors 
used throughout the entire document as opposed to those neighboring each other. 
Finally, the Restrictive setting limits the color table to the outdated Web Safe color 
palette of 216 colors. This 
palette was used in the 
early ages of the Web to 
identify colors that could be 
rendered by a majority of 
monitors. Today, you’d be 
hard-pressed to find a user 
who is using a monitor with 
such a limited color palette, 
which makes the Restrictive 
setting basically worthless. 

Colors 
A GIF can store 256 colors 
in its color table, but it can 
also be manually restricted 
to fewer. Lowering the 
number of colors can help 
reduce the size of the file 
and can sometimes be done 
without degrading the 
image. 
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Dithering 
Reproducing color gradations with such a limited color palette can prove quite 
challenging. Even a simple gradient can contain hundreds of shades, quickly filling 
your color table. But simply stripping some of the colors out can create unwanted 
banding. To combat this, Photoshop lets you run the image through a Dithering 
algorithm, which strategically distributes pixels of different colors through the 
gradation. This is similar to pointillism, because it relies on our eyes to mix the
colors into a seamless gradation. 

There are four options
for dithering. No Dither 
completely removes 
dithering, which can 
result in color bands. 
The Diffusion setting 
applies a diffuse 
pattern, which spaces 
pixels out based on the 
concentration of their 
color. Pattern spaces 
out pixels more evenly 
to simulate a half-tone 
pattern; this is more 
stylistic than realistic. 
Finally, the Noise 
setting is similar to Diffusion, but the placement of pixels is more random, resulting 
in grittier gradations. In addition to the dithering algorithm, Photoshop allows you to 
fine-tune the dithering by specifying the amount. 
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Transparency and Matte 
The GIF format allows 1-bit transparency, meaning that a pixel can be either fully 
transparent or fully opaque. This can lead to awkwardly sharp edges and strangely 
colored gradations. You can modify the Transparency Dither algorithm to help 
smoothen some of the gradations, but they’ll often appear gritty. 

The best way to achieve a smooth transparency with a GIF is to matte it on the target 
background color. Using the Matte drop-down menu, you can select the color to be 
filled in areas with varying transparency. For example, if a pixel has an opacity of 
30%, Photoshop will essentially fill in the other 70% with the matte color, which 
creates a blended color with 100% opacity. This technique works great when the 
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image will ultimately reside above a solid color, but it will create seams if placed on a 
pattern or gradient. 

 

Interlaced 
Interlacing is an outdated method of delivering files that allows users with slow 
connections to receive images in progressive segments. Now that a majority of users 
are on broadband connections, this is rarely needed. It also adds weight to the file 
size, so use only if necessary.

Web Snap 
This is another deprecated option that was used to shift colors towards the 216 Web 
Safe color palette. Nowadays, this can just be left at 0%.

Lossy 
The Lossy setting sacrifices the quality of the image to reduce file size. Ideally, you 
would never have to change this setting, but it might help if you don’t mind losing 
some clarity in the image.
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JPEG

Joint Photographic Experts Group (JPEG) compression is drastically different from GIF 
or PNG compression (see pages 161 and 170). The biggest distinction is that JPEG is 
a lossy format, meaning that it compresses files by reducing the quality of the image. 
When handled carefully, this loss of quality is not perceivable to the human eye. 
Despite this compromise, JPEGs are ideal for photographs and other complex 
imagery. JPEGs are also capable of embedding meta data, which is useful for 
including copyright and other information with photographs. 
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Quality 
The Quality setting is the primary means of compressing a JPEG. The lower the 
setting, the more the file is compressed and the worse the image looks. 
Unfortunately, there are no magic numbers here. You’ll have to make a subjective 
decision on how much to compress the file before the loss in quality becomes 
unacceptable.

The Quality  
setting is used  
to find the  
perfect balance  
of clarity and  
file size.
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Progressive 
Progressive JPEGs download in stages, much like interlaced GIFs. This allows users 
with a slow connection to see the image more quickly but at very low quality. The file 
then gains quality progressively. This requires the file to include more data and 
therefore increases the size. This is hardly needed in today’s broadband world. 

Optimized 
Checking this option runs the image through an additional compression technique 
(Huffman coding) to reduce the file size even further. Leaving this option on is 
recommended, because it effectively reduces file size without affecting the quality of 
the image.

Embed Color Profile 
JPEGs are able to store ICC profiles to inform browsers how their data should be 
displayed. Unfortunately, a majority of browsers completely ignore the embedded 
profile. For now, this option is best left unchecked; but as browsers evolve, we’ll start 
to use this option to improve the delivery of images.

Blur 
Because of how the JPEG compression engine operates, blurry areas can be 
compressed far more than areas with sharp color variations. For this reason, 
Photoshop lets you blur an image slightly before exporting. Of course, we rarely 
want blurry images, but there are times when a very slight blur will reduce the file 
size just enough without drastically affecting the clarity of the image.

Matte 
Because JPEGs don’t support transparency, any transparent areas will be filled with 
the color set by the Matte option.
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PNG-8 and PNG-24

The Portable Network Graphics (PNG) format comes in two varieties. The first is 
PNG-8 format, which is similar to the GIF format. It supports 1-bit transparency and 
limits its color table to 256 values. The only real difference is that it doesn’t support 
animation. For details on PNG-8 settings, please refer to the GIF settings on page 
161.

The second PNG format is PNG-24, which provides the best quality of all the 
aforementioned formats. This is a completely lossless format, meaning that the 
image itself is not affected by compression. PNG-24 also supports 8-bit 
transparency. Basically, what you see in the original PSD is what you get in the 
exported version. However, this beautiful output comes at a significant cost: because 
they contain four lossless 8-bit channels, PNG-24 files can be tremendous in size. 
Use only when appropriate.

The settings here are 
pretty simple. You can 
toggle transparency 
and add interlacing 
just like with a GIF. You 
can also add a Matte 
color, but it is added 
only if Transparency is 
off. 

WBMP

Wireless Bitmap 
(WBMP) files were 
developed for use on 
monochromatic 
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wireless devices. They consist of only black and white pixels. Photoshop allows you 
to control the dithering algorithm and amount of dither. Chances are you’ll never use 
this format. 

Other Settings
Convert to sRGB 

If your working space is set to anything other than sRGB, you can check this option 
to have Photoshop convert the image to sRGB before it exports the file. If you’ve 
followed my recommendation in the Color Management chapter (page 10), you can 
leave this option unchecked.

Preview 

The Preview drop-down menu dictates how the image in the optimized panel is 
proofed. If your monitor is properly calibrated and your working space has been set 
correctly, you can set this to Monitor Color to see how the file will appear when 
viewed in the browser. You can also proof the image to see how it would appear on 
Windows or Mac, or you can turn off the proof by setting it to Use Document Profile.

Meta Data 

If you’d like to pass information such as contact information, camera data and 
copyright, you can add it with the Meta Data drop-down menu. This option controls 
which data to include, but the data must first be set with the File Info dialog (File → 
File Info). This information can be saved only in JPEGs. 

Color Table 

When working with an indexed file format (GIF or PNG-8), you’ll want to know 
exactly which colors are being embedded in the file. The Color Table provides this 
information via swatches. Each swatch represents one color in the file. From this 
table you can add, remove and tweak colors. 
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Transparency: Clicking this toggles the selected swatches between fully transparent 
and fully opaque.

Shift/Unshift to Web Palette: This option shifts the selected color to its nearest Web 
Safe color. If already set to a Web Safe color, this shifts it back to the original. 

Lock Color: Locking a color with this button ensures that it is not dropped, regardless 
of any other option that would otherwise remove it.

Add swatch: If your document has fewer than 256 colors, you can click this button to 
add the current Eyedropper color to the table. You’ll notice that the new color is not 
simply added as a new swatch; instead, the color closest to it is converted to that 
color. The swatch is then split in half diagonally to display the old color (upper-left) 
and the shifted color (bottom-right). 
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Delete swatch:
To remove a color from the table, select it — or hold Command (Control) to select 
multiple — and then click the Trash icon. 

Image Size 

If you need to resize an image before exporting it, you can do so with the Image Size 
settings. Resize it to specific dimensions or a percentage, and control the 
interpolation algorithm with the Quality drop-down menu. However, I recommend 
doing all of your resizing outside of the Save for Web and Devices dialog. 

Animation 

The animation settings, supported only in the GIF format, let you control the file’s 
loop settings and preview the animation.

Slices
Modern Web development centers on semantic mark-up and clean CSS. Life, 
however, was not always so idealistic. Web developers once had to rely on tables to 
construct their layouts. This required perfectly aligned table cells containing images 
that were seamlessly stitched together. To speed the process of building these tables 
and cutting the images just right, Photoshop introduced Slices. This simple tool let 
developers dictate where images should be cut and then export the individual 
segments as separate images. It could even export the HTML needed to bring the 
images together in a table.

While the development community has moved past table-based layouts, these still 
serve a purpose. HTML emails have meager and varying CSS support, which means 
that their layouts need to be constructed with tables. Slices are still relevant for this 
reason.
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Creating a slice is easily done with the Slice tool (K). Simply click and drag out a 
rectangle. The areas around your slice will be logically split into other slices, referred 
to as “auto-slices.” Auto-slices work exactly like “user slices” except that you can’t 
resize them directly; but you can promote them to user slices using the Slice 
Selection tool (Shift + K to rotate between the Slice tool and Slice Selection tool). 
Select the slice and click Promote. 

Each slice is delineated by a bounding box and numbered based on its position 
among the other slices. After creating a slice, you can resize it by dragging its 
bounding box, and you can move it by dragging inside the bounding box. If one 
slice overlaps another, their stacking order determines how the image is divided.
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You can modify the stacking order by selecting it with the Slice Selection tool and 
using the stacking order buttons in the properties bar. Slices higher in the stacking 
order take precedence over those lower down.

A slice basically represents a table cell, and Photoshop can export all of the HTML 
necessary to build the table. This is done through the Save for Web and Devices 
dialog. When you open this dialog on an image with slices, things change slightly. All 
of the same file formats and options are there, but you can now give each slice its 
own setting. 

Use the Slice Select tool in the upper-left corner of the dialog to select one or 
multiple slices. Then, set the compression details for the selected slices, which won’t 
affect the unselected ones. You can easily select all of the slices and apply a global 
setting, but you might be able to reduce the file size by setting each slice 
individually, especially because some slices might work better as JPEGs while others 
would benefit from GIF compression. 

Each slice also has some hidden settings that determine how the HTML will be 
written. Double-clicking a slice with the Slice Selection tool opens the Slice Options 
dialog. Here you can change the name, message and alt text, which control the 
image tag’s ID attribute, status bar text and alt attribute, respectively.

You can also add a link to the image by populating the URL and control the link’s 
window target with the Target setting. If the slice does not contain an image, you can 
change the Slice Type option to No Image, and you’ll then be able to add text or 
other HTML in that cell.
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When you’ve optimized all of the slices, click the Save button. At the bottom of the 
Save Optimized As dialog, you’ll see three options: Format, Settings and Slices. 
Format controls what is exported (HTML only, Images only or HTML and Images). 
Settings determines how the images and HTML are exported.

By selecting Other, you gain access to a number of options to control how the HTML 
or XHTML is written, how images should be named and whether to generate a table 
or DIVs and CSS. Upon clicking Save, all the images are exported and the HTML is 
written. While Photoshop can save you time by authoring the HTML, it doesn’t 
necessarily do a great job. You’ll probably need to manually clean up afterwards.
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Summary
I really hope this book has helped remove the barrier between your creativity and 
the computer screen. Mastering your tools is the only way to achieve creative 
freedom. But Photoshop is an extremely complex tool, and conquering it is by no 
means easy. Years of practice and experimentation are the only real way to master 
this application; reading this book is merely a catalyst.

Extending your Photoshop education beyond this book is crucial. Frequenting 
websites dedicated to Photoshop on a regular basis is a good start. But be warned: 
many tutorials you’ll find on the Internet rely on gimmicks and trends. Steer clear of 
the shallow tutorials, and focus on the ones with principles; they will help you grow 
into a better designer.

Once you understand the fundamentals, I encourage you to experiment. Investigate 
unfamiliar tools, apply senseless adjustments, delete important elements and freely 
make mistakes. Little mistakes have a way of imparting tidbits of knowledge and 
sparking creativity. Photoshop is a design laboratory. Throw on your lab coat and 
start mixing things up.

Finally, get involved with the design community. So many incredibly talented people 
are at the top of our field, and they’re more accessible than you might think. Get out 
there and connect with them. Join Twitter, attend conferences, take part in online 
discussions and share what you’ve learned. We all have something valuable to 
contribute, and sharing that knowledge ensures that our industry will continue to 
grow.
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eBook #1: Professional Web Design 
This book presents guidelines for professional 
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with clients, creating a road map to a successful 
portfolio, rules for professional networking and 
tips on designing user interfaces for business 
Web applications. The book shares expert 
advice, and it also helps you learn how to 
respond effectively to design criticism, use 
storytelling for a better user experience and 
apply color theory to your professional designs.
Buy this eBook now for just $9.90!

eBook #2: Successful Freelancing For Web Designers
Being a great Web designer or developer is one 
thing — running a successful freelance business 
another. Whether you already have work 
experience in companies or have just graduated 
from design school, being self-employed 
entails a number of tasks that you most likely 
haven’t had to deal with so far. As a freelance 
Web designer, you also have to be a project 
manager, accountant, controller and IT expert. 
Buy this eBook now for just $9.90!
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